
Français
Informations importantes

Consignes de sécurité
Avertissement: Une utilisation non conforme de l’appareil peut 
entraîner une électrocution mortelle et endommager ou détruire 
l’appareil.

•   Veuillez lire avec attention les notices se rapportant à l’appareil et les 
conserver.

•   Connectez le câble de raccordement de l’appareil uniquement aux boîtes 
de jonction correctement installées et prévues à cet effet.

•   Utilisez exclusivement des accessoires et pièces de rechange d’origine.

Avertissement: Une installation incomplète ou défectueuse peut 
entraîner des risques de blessures, par ex. en raison d’un 
dysfonctionnement des appels d’urgence.

•   La configuration du produit se fait par le téléphone ou par le kit logiciel 
COMfortel. L’aide correspondante est disponible en anglais ou en 
allemand. Si vous ne maîtrisez pas ces langues et si la terminologie ne 
vous est pas familière, faites-vous assister par un professionnel 
spécialisé et comprenant ces langues.

Avertissement: L’utilisation d’un mauvais bloc d’alimentation peut 
entraîner une électrocution mortelle et endommager ou détruire le 
téléphone.

•   N’utilisez que le bloc d’alimentation de type n° FW7577/EU/40.

Avertissement: La pénétration de liquides dans le boîtier peut 
entraîner une électrocution mortelle et endommager ou détruire 
l’appareil.

•   N’utilisez le téléphone que dans des pièces fermées et sèches.
•   Nettoyez l’appareil avec un chiffon légèrement humide ou un chiffon 

antistatique uniquement.

Avertissement: Des lignes de raccordement endommagées ainsi 
que des dommages au niveau du boîtier et sur l’appareil peuvent 
entraîner une électrocution mortelle.

•   Ne faites pas fonctionner d’appareil endommagé.

Avertissement: Des surtensions, telles que celles survenant lors 
d’un orage, peuvent entraîner une électrocution mortelle et 
endommager ou détruire l’appareil.

•   Lors d’un orage, ne touchez pas l’appareil.
•   Tous les câbles dans les bâtiments ne doivent être posés que par un 

électricien qualifié.

Avertissement: L’utilisation de micro-casques, de haut-parleurs ou 
écouteurs externes non adaptés peut entraîner une perte auditive ou 
dégrader la qualité de la conversation.

•   Pour connecter un micro-casque, respectez les spécifications 
techniques.

Avertissement: En raison du faible champ magnétique dans 
l’écouteur, des objets attirés par l’aimant, comme des aiguilles ou des 
trombones, peuvent entraîner des blessures.

•   Ne posez pas l’écouteur à proximité de tels objets.

Avertissement: Danger d’étouffement. L’appareil contient des 
petites pièces susceptibles d’être avalées par des enfants en bas 
âge.

•   Tenez l’appareil hors de la portée des jeunes enfants.

Important: L’appareil n’est pas prévu pour des systèmes de survie et/ou 
pour des utilisations dans des installations nucléaires et ne doit donc pas 
être utilisé dans ces conditions. Une utilisation de l’appareil dans de telles 
conditions doit obligatoirement faire l’objet d’une autorisation individuelle 
spécifique écrite du fabricant.
Une utilisation non conforme peut par ex. entraîner une limitation des 
fonctions ou bien des dysfonctionnements, la destruction de l’appareil ou, 
dans les cas les plus graves, la mise en danger de personnes.
•   Si, malgré avoir lu le chapitre suivant, vous avez des doutes quant à 

l’utilisation conforme, veuillez vous adresser à votre revendeur.
•   Veuillez lire avec attention les notices se rapportant à l’appareil et les 

conserver pour une utilisation ultérieure.
•   Pour l’utilisation de certaines fonctions, une activation par l’exploitant du 

réseau, une mise à jour de la version du logiciel et/ou une 
configuration sont nécessaires. 

Utilisation conforme
Téléphone pour connexion au port interne S0 ou UP0 d’un système de 
télécommunication Auerswald/FONtevo (cf. spécifications techniques). Le 
raccordement à un système de télécommunication d’un autre fabricant ou à 
la prise externe S0 d’un exploitant de réseau n’est pas prévu. Le téléphone 
est raccordé avec des câbles et conçu pour une utilisation dans des pièces 
fermées et sèches.

Spécifications techniques

Spécifications techniques pour la connexion d’un micro-casque

Consignes relatives à l’environnement
Si l’appareil n’est plus utilisé, veuillez vous assurer qu’il est mis au rebut de 
manière appropriée (et n’est pas jeté avec les ordures ménagères).

Veuillez jeter ou recycler l’emballage dans le respect de 
l’environnement.

Tension en 
fonctionnement

Alimentation par port interne S0 ou UP0 du système 
de télécommunication, avec 
COMfortel Xtension300 : alimentation par bloc 
d’alimentation nécessaire ; 230 V ~ ; +/- 10 %, 50 Hz

Bloc 
d’alimentation

type n° FW7577/EU/40

Puissance 
absorbée

1,1 W min., 1,9 W max. ; COMfortel Xtension300 : 
+0,6 W

Raccordement au 
système

Port interne S0 ou UP0 du système de 
télécommunication : COMpact 3000 analogique/
ISDN/VoIP, COMpact 2206 USB, COMpact 4410 
USB, COMpact 5010 VoIP, COMpact 5020 VoIP, 
COMpact 4000, COMpact 5000/R, COMpact 5200/
R, COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19", COMmander Business/
19"

Interface PC/
données

USB

Affichages 18 LED, dont 15 multicolores, écran couleur TFT 
4,3’’, 480 x 272 pixels, rétro-éclairage

COMfortel Xtension300 : 30 LED, multicolores
Éléments de 
commande

Clavier téléphonique, 12 boutons à fonction fixe, 
écran couleur avec fonction tactile, croix 
directionnelle, 15 boutons à fonction programmable 
avec LED (avec chacune deux fonctions à affecter 
sur deux niveaux)

COMfortel Xtension300 : 30 boutons fonctionnels 
programmables

Écouteur Audio à large bande, microphone à électret, haut-
parleur écouteur dynamique, compatible avec 
appareils auditifs

Micro-casque Interface séparée pour micro-casques à fil, 
également compatibles DHSG

Crochet 
commutateur

Commutateur de contact magnétique

Boîtier Plastique, noir, blanc
Dimensions 275 mm x 128/150/170 mm x 210 mm (l x h x p) ; 

COMfortel Xtension300 : 120 x 68/90/110 X 210 
Poids env. 1 050 g ; COMfortel Xtension300 : env. 310 g
Température Fonctionnement : 0 à 40 °C, entreposage : - 30 à 

+ 70 °C, sans condensation
Sécurité CE

Alimentation microphone 0,5 mA max.
Sensibilité microphone 45 dB
Impédance haut-parleur 150 Ohm
Sensibilité haut-parleur pour 1 kHz 19,5 +/- 3 dBPa/V
Limite du niveau sonore 24 dBPa
Renseignez-vous auprès de votre ville ou commune pour savoir quelles sont 
les possibilités de recyclage et de gestion des déchets pouvant s’appliquer 
à l’appareil. Si vous souhaitez que nous nous chargions de la gestion des 
déchets liés à l’appareil, envoyez l’appareil à vos frais à Auerswald GmbH & 
Co. KG.

Déclaration de conformité
Cet appareil répond aux exigences relatives à la santé, la sécurité et 
l’environnement de toutes les directives européennes en vigueur. La déclaration 
de conformité peut être consultée sur Internet.

Notices
La notice « Informations complémentaires » est disponible dans le COMfortel Set ainsi que sur Internet. Vous trouverez la 
notice abrégée sur Internet. Après une mise à jour de la version du logiciel, vous aurez besoin de notices actualisées. Elles 
sont disponibles sur Internet.

Conditions de garantie
1. La société Auerswald GmbH & Co. KG, Vor den Grashöfen 1, D-38162 Cremlingen, accorde une garantie fabricant sur 
ce produit, pour une durée de 24 mois suivant la date d’achat.
2. Pour vous en tant que client, ceci signifie que : nous garantissons que nos appareils sont irréprochables en l’état à la 
livraison et que nous nous engageons, pour une période de 24 mois suivant cette date, à effectuer une réparation ou à livrer 
une pièce de rechange sans coûts supplémentaires dans le cas où un défaut de fabrication serait constaté, et que nous 
renonçons à exiger de vous, en qualité de client, la présentation d’une preuve de présence du défaut à la livraison comme 
ceci est généralement le cas dans le respect de la garantie légale. Lors de la réparation ou de la livraison de la pièce de 
rechange, nous utilisons des pièces neuves ou des pièces à l’état neuf. Le cas échéant, les pièces retirées de l’appareil 
nous appartiennent et peuvent être détruites.
3. En plus de cette garantie, le client dispose pleinement des droits relatifs à la garantie légale de conformité sur la base 
du contrat de vente conclu avec le distributeur/revendeur qui lui sont conférés par la loi. La garantie légale de conformité 
ne concerne que la qualité de la marchandise au moment de la vente (transfert), contrairement à notre garantie fabricant. 
4. Vous ne pouvez faire valoir cette garantie que lorsque vous envoyez à vos frais l’appareil défectueux accompagné d’une 
preuve d’achat (facture ou ticket de caisse) à Auerswald GmbH & Co. KG ou, hors d’Allemagne, à notre importateur général 
ou distributeur sur place. Veuillez joindre à cet envoi une description détaillée du défaut ainsi que votre numéro de 
téléphone afin que nous puissions vous contacter au besoin. Afin d’éviter tout dommage lors du transport, veuillez vous 
assurer que l’appareil est placé dans un emballage adapté (par ex. emballage original placé dans un carton).
5. Les dommages résultant d’une utilisation non conforme, d’erreurs de manipulation, d’une utilisation abusive, d’influences 
extérieures, de la foudre/d’une surtension, d’une modification du produit et d’ajouts, sont exclus de la garantie fabricant. 
Les pièces d’usure sont également exclues de la garantie (par ex. piles, fusibles, batteries, cartes mémoires), tout comme 
les dommages résultant des pièces d’usures (par ex. en raison de piles déchargées). Les dommages résultant du transport, 
les dommages consécutifs ainsi que les coûts liés aux temps d’attente et d’acheminement, sont également exclus de la 
garantie fabricant.
6. La garantie est rendue caduque lors de l’exécution de réparations effectuées par des organismes non autorisés. 

Première mise en service
Raccordez le téléphone comme représenté sur l’illustration sous Raccordement.

Première configuration du téléphone
Prérequis :
• Numéros d’appel internes paramétrés dans le système de télécommunication
Suivez les indications dans le téléphone. 

Remarque: Le MSN est le numéro d’appel interne paramétré dans le système de 
télécommunication.

Configuration via le COMfortel Set
Prérequis :
• Java Runtime est installé (disponible sur Internet)
• COMfortel Set est installé (disponible sur Internet)
• Connexion existante du PC à une interface PC du système de 

télécommunication (cf. notice du système de télécommunication)
1. Lancez le programme.
2. Sous Options > Interface, sélectionnez l’interface que vous utilisez (par ex. 

Réseau IP lors de la connexion du PC avec le système de télécommunication 
via le réseau local).

3. Cliquez sur Ouvrir > Téléphone et sélectionnez le téléphone concerné.
4. Entrez le code PIN.
5. Effectuez les réglages souhaités.
6. Enregistrez ensuite la configuration dans le téléphone. Cliquez enfin sur 

Fichier > Enregistrer > Téléphone dans cet ordre.

Italiano
Informazioni importanti

Indicazioni di sicurezza
Pericolo: L’uso improprio del dispositivo può causare una scossa elettrica 
mortale e danneggiare o distruggere il dispositivo.

•   Leggere e conservare le guide fornite insieme al dispositivo.
•   Collegare il cavo del dispositivo solo a prese idonee e installate a regola d’arte.
•   Utilizzare esclusivamente accessori e ricambi originali.

Pericolo: Un’eventuale configurazione incompleta o errata può risultare 
pericolosa per gli utenti, per es. nel caso in cui non sia possibile effettuare 
le chiamate di emergenza.

•   Il prodotto può essere configurato tramite il telefono o tramite il software 
COMfortel Set. La guida corrispondente è disponibile in lingua inglese o 
tedesca. In caso di scarsa padronanza di tali lingue e dei termini tecnici 
utilizzati, rivolgersi a un tecnico con conoscenze linguistiche adeguate.

Pericolo: L’uso di un alimentatore a spina inadeguato può causare una 
scossa elettrica mortale e danneggiare o distruggere il telefono.

•   Utilizzare solo l’alimentatore a spina di tipo FW7577/EU/40.

Pericolo: La penetrazione di liquidi nel dispositivo può causare una scossa 
elettrica mortale e danneggiare o distruggere il dispositivo.

•   Utilizzare il telefono solo in locali chiusi e asciutti.
•   Pulire il dispositivo solo con un panno leggermente inumidito o un panno 

antistatico.

Pericolo: I cavi di collegamento danneggiati, così come eventuali danni in 
corrispondenza dell’involucro e del dispositivo, possono causare una 
scossa elettrica mortale.

•   Non mettere in funzione un dispositivo danneggiato.

Pericolo: Le sovratensioni, per esempio quelle che si formano durante i 
temporali, possono causare una scossa elettrica mortale e danneggiare o 
distruggere il dispositivo.

•   Durante i temporali evitare di toccare il dispositivo.
•   Tutti i cavi dell’edificio devono essere posati da un elettricista qualificato.

Pericolo: Cuffie auricolari, altoparlanti esterni o ricevitori inadeguati 
possono danneggiare l’udito o disturbare il collegamento audio.

•   Rispettare i dati tecnici per il collegamento di una cuffia auricolare.

Pericolo: Gli oggetti attirati dal debole campo magnetico del ricevitore, 
come puntine e fermagli, possono causare lesioni.

•   Non appoggiare il ricevitore in prossimità di tali oggetti.

Pericolo: Pericolo di soffocamento. Il dispositivo contiene particolari di 
piccole dimensioni che possono essere inghiottiti dai bambini.

•   Tenere il dispositivo fuori dalla portata dei bambini.

Importante: Il dispositivo non è progettato per sistemi vitali e/o per applicazioni 
nell’ambito di impianti nucleari e pertanto non deve essere utilizzato a tali scopi. 
L’uso del dispositivo per applicazioni di questo tipo presuppone obbligatoriamente 
la presenza di un consenso/una dichiarazione scritti del produttore per il caso 
specifico.
L’uso improprio può limitare le funzioni del dispositivo, causarne un 
malfunzionamento o la distruzione oppure, nel peggiore dei casi, creare situazioni 
pericolose per le persone.
•   Qualora, anche dopo avere letto il capitolo seguente, permangano dubbi 

sull’uso previsto, rivolgersi al proprio rivenditore specializzato.
•   Leggere le guide fornite insieme al dispositivo e conservarle per ogni utilizzo 

futuro.
•   Per usufruire di alcune funzioni può essere necessario richiedere un’attivazione 

presso l’operatore di rete, eseguire un aggiornamento del firmware e/o 
eseguire una configurazione tramite COMfortel Set. 

Uso previsto
Telefono di sistema da collegare alla porta S0 o UP0 interna di un centralino 
Auerswald/FONtevo (vedere i dati tecnici). Il collegamento a un centralino di un 
altro produttore o alla porta S0 esterna di un operatore di rete non è consentito. Il 
telefono è collegato via cavo e progettato per essere utilizzato in locali chiusi e 
asciutti.

Dati tecnici

Dati tecnici per il collegamento di una cuffia auricolare

Note di carattere ambientale
Qualora il dispositivo non serva più, smaltirlo a regola d’arte (non insieme ai 
normali rifiuti domestici).

Smaltire il materiale dell’imballaggio nel rispetto dell’ambiente e delle norme 
vigenti in materia.

Informarsi presso le autorità locali o comunali sulle modalità di smaltimento 
corrette ed ecologiche del dispositivo. Su richiesta, Auerswald può farsi 
carico dello smaltimento. Per avvalersi di tale possibilità spedire il dispositivo 
a proprie spese ad Auerswald GmbH & Co. KG.

Dichiarazione di conformità
Il presente dispositivo soddisfa i requisiti fondamentali in materia di salute, 
sicurezza e ambiente di tutte le direttive europee applicabili. La dichiarazione di 
conformità può essere consultata in Internet.

Guide
La guida “Ulteriori informazioni” è disponibile in COMfortel Set e in Internet. La guida rapida è disponibile in Internet. Dopo 
un aggiornamento del firmware possono servire guide aggiornate. Queste sono disponibili in Internet.

Condizioni di garanzia
1. In qualità di produttore, Auerswald GmbH & Co. KG, Vor den Grashöfen 1, D-38162 Cremlingen, Germania, concede su 
questo prodotto 24 mesi di garanzia del produttore a partire dalla data di acquisto.
2. Per il consumatore questo significa che: garantiamo la consegna di dispositivi privi di difetti e provvediamo alla loro 
riparazione o sostituzione gratuita qualora emerga un difetto di produzione per 24 mesi a partire dalla data di consegna. 
Facciamo a meno della prova che il consumatore deve fornire ai sensi della garanzia di legge a dimostrazione che il difetto 
era già presente al momento della consegna. Per la riparazione o la fornitura sostitutiva utilizziamo componenti nuovi o 
come nuovi. I componenti eventualmente rimossi dal dispositivo diventano di nostra proprietà e possono essere distrutti.
3. Oltre alla presente garanzia, al cliente spettano tutti i diritti di legge nei confronti del fornitore risultanti dalla garanzia per 
vizi della cosa venduta sulla base del contratto di compravendita. A differenza della garanzia del produttore da noi 
concessa, la garanzia di legge per i vizi della cosa venduta riguarda unicamente le condizioni al momento della vendita 
(consegna). 
4. È possibile usufruire della presente garanzia solo inviando ad Auerswald GmbH & Co. KG o, se vi trovate al di fuori della 
Germania, al nostro importatore generale o distributore locale, il dispositivo difettoso unitamente a un documento 
giustificativo dell’acquisto (fattura o scontrino inequivocabili). Allegare all’invio anche una descrizione dettagliata del difetto 
e riportare il proprio numero di telefono per eventuali richieste di chiarimento. Per evitare che il dispositivo subisca danni 
durante il trasporto, imballarlo adeguatamente (per es. inserire il dispositivo nell’imballaggio originale, quindi all’interno di 
un’ulteriore scatola di cartone).
5. La garanzia del produttore non copre i danni causati da gestione inadeguata, errore di azionamento, uso improprio, 
influssi esterni, fulmini/sovratensioni, modifiche del prodotto e aggiunta di componenti. La garanzia non si applica ai 
componenti soggetti a usura (per es. batterie, fusibili, batterie ricaricabili, schede di memoria) e non copre eventuali danni 
causati da tali componenti (per es. in seguito all’esaurirsi delle batterie). La garanzia non copre neppure i danni di trasporto, 
i danni indiretti e i costi subiti in seguito ai tempi di fuori servizio e di transito.
6. Eventuali riparazioni eseguite da centri non autorizzati provocano la decadenza del diritto alla garanzia. 

Prima messa in funzione
Collega il telefono come illustrato nella figura riportata sotto a “Collegamento”.

Prima configurazione del telefono
Requisiti:
• numero di telefono interno configurato nel centralino.
Segui le istruzioni sul telefono. 

Nota: L’MSN è il numero di telefono interno configurato nel centralino.

Configurazione tramite COMfortel Set
Requisiti:
• Java Runtime installato (disponibile in Internet)
• COMfortel Set installato (disponibile in Internet)
• Connessione tra il PC e un’interfaccia PC del centralino (vedere la guida del 

centralino)
1. Avvia il programma.
2. Alla voce Opzioni > Interfaccia seleziona l’interfaccia utilizzata (per es. Rete 

IP nel caso in cui il PC sia connesso con il centralino tramite la rete locale).
3. Clicca su Apri > Telefono e seleziona il telefono in oggetto.
4. Immetti il PIN.
5. Esegui le impostazioni desiderate.
6. quindi salva la configurazione nel telefono. Per fare ciò clicca su File > Salva 

> Telefono.

Nederlands
Belangrijke informatie

Veiligheidsinstructies
Waarschuwing: Verkeerde omgang met het apparaat kan 
levensgevaarlijke elektrische schokken tot gevolg hebben en het apparaat 
beschadigen.

•   Lees de bij het apparaat behorende handleidingen door en bewaar deze.
•   Sluit de aansluitkabel van het apparaat alleen aan op de daarvoor bedoelde en 

deskundig geïnstalleerde contactdozen
•   Gebruik uitsluitend originele toebehoren en originele reservedelen.

Waarschuwing: Onvolledige of verkeerde configuratie kan gevaar voor 
personen tot gevolg hebben, bijvoorbeeld doordat noodoproepen niet 
kunnen worden uitgevoerd.

•   De configuratie van het apparaat geschiedt via de telefoon of via de software 
COMfortel-set. De bijbehorende hulp is beschikbaar in de Engelse of de Duitse 
taal. Wanneer u niet bekend bent met deze talen en de gebruikte vaktermen, 
schakel dan een vaktechnicus in die deze wel beheerst.

Waarschuwing: Het gebruik van de verkeerde adapter kan 
levensgevaarlijke elektrische schokken tot gevolg hebben en de telefoon 
beschadigen of kapot maken.

•   Gebruik enkel de adapter met type-nr. FW7577/EU/40.

Waarschuwing: Vloeistof dat de behuizing binnendringt kan 
levensgevaarlijke elektrische schokken tot gevolg hebben en het apparaat 
beschadigen.

•   Gebruik de telefoon alleen in gesloten, droge ruimten.
•   Reinig het apparaat alleen met een licht vochtige doek of een antistatische 

doek.

Waarschuwing: Beschadigde aansluitkabels en beschadigingen aan de 
behuizing en aan het apparaat zelf, kunnen levensgevaarlijke elektrische 
schokken tot gevolg hebben.

•   Neem een beschadigd apparaat nooit in bedrijf.

Waarschuwing: Overspanningen, zoals bij onweer kunnen optreden, 
kunnen levensgevaarlijke elektrische schokken tot gevolg hebben of het 
apparaat beschadigen of kapot maken.

•   Raak het apparaat niet aan tijdens een onweersbui.
•   Laat door een elektrotechnicus alle kabels binnen het gebouw installeren.

Waarschuwing: Ongeschikte headsets, externe luidsprekers of 
koptelefoons kunnen tot gehoorschade leiden of de spraakverbinding 
storen.

•   Neem de technische gegevens voor het aansluiten van een headset in acht.

Waarschuwing: Het zwakke magnetische veld in de koptelefoon kan 
objecten als naalden en paperclips aantrekken. Deze objecten kunnen 
letsel veroorzaken.

•   Leg de koptelefoon niet in de buurt van dergelijke objecten neer.

Waarschuwing: Verstikkingsgevaar. Het apparaat bevat kleine onderdelen 
die door kleine kinderen kunnen worden ingeslikt.

•   Houd het apparaat buiten bereik van kleine kinderen

Belangrijk: Het apparaat is niet bedoeld, en mag daarom niet worden gebruikt, 
voor life-support systemen en/of toepassingen binnen nucleaire inrichtingen. Voor 
gebruik van het apparaat in dergelijke toepassingen moet verplicht een op het 
individuele geval afgestemde schriftelijke toestemming/verklaring van de fabrikant 
vooraf worden afgegeven
Niet correct gebruik kan bijvoorbeeld functiebeperkingen of storingen, 
onherstelbare schade aan het apparaat of, in het ergste geval, gevaar voor 
personen tot gevolg hebben.
•   Wanneer u betreffende het correcte gebruik, ook na het lezen van het volgende 

hoofdstuk, nog twijfelt, neem dan contact op met uw dealer.
•   Lees de bij het apparaat behorende handleidingen door en bewaar deze voor 

later gebruik.
•   Voor het gebruik van bepaalde functies is een vrijschakeling bij de 

netbeheerder, een firmware-update en/of een configuratie via de COMfortel Set 
vereist. 

Correct gebruik
Systeemtelefoon voor aansluiting op de interne S0- of UP0-poort van een 
telefooncentrale van Auerswald/FONtevo (zie technische gegevens). De 
verbinding is niet bedoeld voor aansluiting op een telefooncentrale van een andere 
fabrikant of op de externe S0-aansluiting van een netbeheerder. De telefoon is 
bedraad en bedoeld om in gesloten, droge ruimten te worden gebruikt.

Technische gegevens

Technische gegevens voor het aansluiten van een headset

Milieuvoorschriften
Wanneer het apparaat eens is uitgediend, let dan op een correcte afvoer (niet in 
het normale huisvuil).

Voer het verpakkingsmateriaal correct af om het milieu te sparen.

Informeer bij uw lokale autoriteiten naar de mogelijkheden voor het 
milieuvriendelijk afvoeren van uw apparaat. Wanneer u wilt, dat wij het 
apparaat voor u afvoeren, stuur het apparaat dan voor uw eigen rekening 
naar Auerswald GmbH & Co. KG.

Conformiteitsverklaring
Dit apparaat voldoet aan de principiële gezondheids-, veiligheids- en 
milieuvoorschriften uit alle relevante Europese richtlijnen. De 
conformiteitsverklaring kan op internet worden ingezien.

Handleidingen
De handleiding “Aanvullende informatie” vindt u in de COMfortel Set van de telefoon en op het internet. Een korte 
handleiding vindt u op het internet. Na een firmware-update heeft u evt. geactualiseerde handleidingen nodig. Deze vindt 
u op internet.

Garantievoorwaarden
1. Auerswald GmbH & Co. KG, Vor den Grashöfen 1, D-38162 Cremlingen, verleent als fabrikant op dit product 24 
maanden fabrieksgarantie vanaf de koopdatum.
2. Dit betekent voor u als gebruiker: Wij garanderen, dat onze apparaten bij de overdracht foutloos functioneren en zorgen 
tot 24 maanden vanaf deze datum voor een kostenloze reparatie of wij leveren kosteloos een vervangen, indien een 
fabricagefout optreedt en zien af van het door u als verbruiker aan te voeren bewijs als bij de wettelijke garantie, dat deze 
fout op het tijdstip van overdracht al aanwezig was. Bij de reparatie of de levering van vervangende onderdelen gebruiken 
wij nieuwe of gelijkwaardige onderdelen. Het apparaat en eventueel uitgenomen onderdelen gaan over in ons eigendom 
en mogen worden vernietigd.
3. Naast deze garantie heeft de klant in volledige omvang het wettelijke recht op garantie op basis van het koopverdrag ten 
opzichte van de leverancier. De wettelijke garantie betreft echter in tegenstelling tot onze fabrieksgarantie alleen de kwaliteit 
op het tijdstip van verkoop (overdracht). 
4. U kunt alleen aanspraak maken op deze garantie, wanneer u het defecte apparaat met een eenduidig koopbewijs 
(factuur of kassabon) op uw kosten aan Auerswald GmbH & Co. KG verzendt of, buiten Duitsland, aan onze importeur of 
distributeur ter plaatse. Voeg aan deze zending een uitgebreide foutbeschrijving tot en vermeld voor eventuele vragen ook 
uw telefoonnummer. Zorg voor geschikte transportverpakking om transportschade te voorkomen (bijvoorbeeld originele 
verpakking met een omdoos).
5. Uitgesloten van de fabrieksgarantie is schade, die ontstaat door verkeerde behandeling, bedieningsfouten, misbruik, 
externe invloeden, blikseminslag/overspanning, veranderingen van het product en aangebouwde componenten. 
Bovendien zijn de slijtende delen uitgesloten (bijv. batterijen, zekeringen, accu's, geheugenkaarten), en door de slijtende 
delen veroorzaakte schade (bijv. door het uitlopen van batterijen). Ook transportschade, gevolgschade en kosten voor 
uitvaltijden zijn uitgesloten.
6. De garantie komt te vervallen wanneer reparaties door niet geautoriseerde instanties worden uitgevoerd. 

Eerste ingebruikname
Sluit de telefoon aan zoals op de afbeelding onder aansluiting wordt weergegeven.

Eerste configuratie via de telefoon
Voorwaarden:
• Bij de telefooncentrale ingesteld intern telefoonnummer
Volg de instructies in de telefoon. 

Opmerking: De MSN is het in de telefooncentrale ingestelde interne 
telefoonnummer.

Configuratie via COMfortel Set
Voorwaarden:
• Java Runtime geïnstalleerd (vindt u op het internet)
• COMfortel Set geïnstalleerd (vindt u op het internet)
• Bestaande verbinding van de PC met een PC-interface van de telefooncentrale 

(zie handleiding van de telefooncentrale)
1. Start het programma.
2. Selecteer onder Options > Interface de door u gebruikte interface (bijv. IP 

network als de PC middels het lokale netwerk met de telefooncentrale is 
verbonden).

3. Klik op Open > Telephone en selecteer de betreffende telefoon.
4. Voer de PIN in.
5. Voer de gewenste instellingen door.
6. Sla hierna de configuratie op in de telefoon. Klik hiervoor achtereenvolgens op 

File > Save > Telephone.

Polski
Ważne informacje

Wskazówki bezpieczeństwa
Ostrzeżenie: Nieprawidłowe używanie urządzenia może doprowadzić do 
groźnego dla życia porażenia prądem, a także uszkodzić lub zniszczyć 
urządzenie.

•   Należy przeczytać załączone instrukcje obsługi urządzenia i zachować je.
•   Przewody urządzenia należy podłączać wyłącznie do odpowiednich i fachowo 

zainstalowanych gniazd przyłączeniowych
•   Należy używać wyłącznie oryginalnych akcesoriów i części zamiennych.

Ostrzeżenie: Niekompletna lub błędna konfiguracja może prowadzić do 
zagrożenia życia, np. poprzez brak możliwości wykonania połączenia w 
celu wezwania pomocy.

•   Konfiguracja produktu odbywa się przez telefon lub przez oprogramowanie 
COMfortel Set. Właściwa pomoc jest dostępna w języku angielskim lub 
niemieckim. Jeżeli te języki i zastosowane fachowe pojęcia sprawiają trudność, 
to należy powierzyć te czynności osobie z odpowiednimi kwalifikacjami 
językowymi i fachowymi.

Ostrzeżenie: Używanie niewłaściwego wtykowego zasilacza sieciowego 
może doprowadzić do groźnego dla życia porażenia prądem, a także 
uszkodzić lub zniszczyć telefon.

•   Stosować tylko wtykowy zasilacz sieciowy o nr. typu FW7577/EU/40.

Ostrzeżenie: Zalanie obudowy płynem może doprowadzić do śmiertelnego 
porażenia prądem, a także uszkodzić lub zniszczyć urządzenie.

•   Telefonu należy używać wyłącznie w zamkniętych i suchych pomieszczeniach.
•   Urządzenie należy czyścić wyłącznie za pomocą lekko zwilżonej szmatki lub 

ściereczki antystatycznej.

Ostrzeżenie: Uszkodzenia przewodów, obudowy lub urządzenia mogą 
prowadzić do śmiertelnego porażenia prądem.

•   Nie należy włączać uszkodzonego urządzenia.

Ostrzeżenie: Występujące podczas burzy przepięcia mogą doprowadzić 
do śmiertelnego porażenia prądem, a także uszkodzić lub zniszczyć 
urządzenie.

•   W czasie burzy nie należy dotykać urządzenia.
•   Rozmieszczaniem przewodów w budynku powinien zająć się wykwalifikowany 

elektryk.

Ostrzeżenie: Nieodpowiednie zestawy słuchawkowe, zewnętrzne głośniki 
lub słuchawki mogą prowadzić do uszkodzenia słuchu lub powodować 
zakłócenia połączeń głosowych.

•   Przestrzegać danych technicznych dotyczących podłączania zestawu 
słuchawkowego.

Ostrzeżenie: Przedmioty przyciągnięte przez słabe pole magnetyczne w 
słuchawce, takie jak igły lub spinacze biurowe, mogą spowodować 
skaleczenia.

•   Nie należy umieszczać słuchawki w pobliżu takich przedmiotów.

Ostrzeżenie: Niebezpieczeństwo uduszenia. W urządzeniu znajdują się 
drobne elementy, które dzieci mogą połknąć.

•   Urządzenie należy przechowywać poza zasięgiem małych dzieci

Ważne: Niniejsze urządzenie nie jest przeznaczone do użytku w systemach 
podtrzymywania życia i/lub w urządzeniach nuklearnych i nie powinno być w nich 
stosowane. Aby niniejsze urządzenie mogło być wykorzystywane do tego typu 
zastosowań, dla każdego pojedynczego przypadku bezwzględnie wymagana jest 
uprzednia pisemna zgoda lub oświadczenie ze strony producenta
Użytkowanie niezgodne z przeznaczeniem może prowadzić np. do ograniczenia 
funkcjonalności, zakłóceń w działaniu urządzenia, jego zniszczenia, a w skrajnym 
wypadku do zagrożenia życia.
•   Jeżeli po przeczytaniu poniższego rozdziału nadal zachodzą wątpliwości co do 

zgodnego z przeznaczeniem użytkowania urządzenia, należy zasięgnąć 
informacji u sprzedawcy.

•   Należy przeczytać załączone instrukcje obsługi urządzenia i zachować je do 
późniejszego użytku.

•   Do korzystania z niektórych funkcji konieczna jest ich aktywacja u operatora 
sieci, aktualizacja oprogramowania sprzętowego i/lub konfiguracja przez 
COMfortel Set. 

Użytkowanie zgodne z przeznaczeniem
Telefon systemowy do podłączania do wewnętrznego portu S0 lub UP0 centrali 
telefonicznej firmy Auerswald/FONtevo (patrz Dane techniczne). Podłączenie do 
centrali telefonicznej innego producenta lub do zewnętrznego przyłącza S0 
operatora sieci nie jest przewidziane. Jest to telefon przewodowy, przeznaczony 
do użytku w zamkniętych i suchych pomieszczeniach.

Dane techniczne

Dane techniczne przyłącza zestawu słuchawkowego

Informacje dotyczące ochrony środowiska
Po zakończeniu użytkowania urządzenia należy zadbać o jego odpowiednią 
utylizację (oddzielnie od odpadów komunalnych).

Materiał opakowaniowy należy zutylizować w sposób zgodny z 
zasadami ochrony środowiska.

W administracji miasta lub gminy należy zasięgnąć informacji o możliwości 
prawidłowej utylizacji urządzenia, zgodnej z zasadami ochrony środowiska. 
Urządzenie, które ma zostać zutylizowane, można również przesłać na swój 
koszt do firmy Auerswald GmbH & Co. KG.

Deklaracja zgodności
Niniejsze urządzenie spełnia podstawowe wymagania dotyczące zdrowia, 
bezpieczeństwa i ochrony środowiska naturalnego wszystkich właściwych 
dyrektyw europejskich. Z tą deklaracją zgodności można zapoznać się w 
Internecie.

Instrukcje
Instrukcja „Informacje rozszerzone” znajduje się w COMfortel Set i w Internecie. Skrócona instrukcja znajduje się w 
Internecie. Po zaktualizowaniu oprogramowania wewnętrznego mogą być ewentualnie potrzebne zaktualizowane 
instrukcje. Można je znaleźć w Internecie.

Warunki gwarancji
1. Spółka Auerswald GmbH & Co. KG, Vor den Grashöfen 1, D-38162 Cremlingen, przyznaje jako producent 24-miesięczną 
gwarancję producenta na ten produkt, która rozpoczyna się w dniu zakupu.
2. Dla Państwa jako konsumenta oznacza to, co następuje: Gwarantujemy, że nasze urządzenia w momencie ich 
przekazania nie posiadają usterek, i zapewniamy bezpłatną naprawę lub darmową wymianę w ciągu 24 miesięcy od tej 
daty, w przypadku gdy w urządzeniu wykryta zostanie wada fabryczna, i rezygnujemy z obowiązku przedstawienia przez 
Państwa jako konsumenta dowodu, że dana usterka występowała już w momencie przekazania produktu, co jest 
wymagane w przypadku ustawowej rękojmi. W przypadku naprawy lub wymiany używamy nowych części lub części 
posiadających wartość nowego produktu. Ewentualne części wymontowane z urządzenia stają się naszą własnością i 
mogą zostać zutylizowane.
3. Oprócz niniejszej gwarancji klientowi w pełnym zakresie przysługują ustawowe prawa z tytułu rękojmi przyznawanej na 
mocy umowy sprzedaży zawartej z dostawcą. W przeciwieństwie do naszej gwarancji producenta ustawowa rękojmia 
dotyczy tylko jakości w momencie sprzedaży (przekazania). 
4. Z niniejszej gwarancji mogą Państwo skorzystać wyłącznie po przesłaniu wadliwego urządzenia na własny koszt wraz z 
jednoznacznym dowodem zakupu (rachunkiem lub paragonem) do firmy Auerswald GmbH & Co. KG bądź do naszego 
importera generalnego lub miejscowego dystrybutora, w przypadku klientów spoza Niemiec. Prosimy także o dołączenie 
do wysyłki szczegółowego opisu uszkodzenia i o podanie numeru telefonu do kontaktu w przypadku ewentualnych pytań. 
Aby uniknąć uszkodzeń w transporcie, należy zadbać o odpowiednie opakowanie na czas transportu (np. opakowanie 
oryginalne i karton zewnętrzny).
5. Gwarancją producenta nie są objęte szkody, które powstają na skutek niewłaściwego użytkowania, błędu operatora, 
nadużywania, czynników zewnętrznych, uderzenia pioruna/przepięcia, modyfikacji produktu lub jego rozbudowy. Ponadto 
gwarancja nie obejmuje części ulegających zużyciu (np. baterii, bezpieczników, akumulatorów, kart pamięci), a także 
uszkodzeń spowodowanych przez takie części (np. w wyniku wyczerpania się baterii). Ponadto z zakresu gwarancji 
wyłączone są szkody powstałe w transporcie, szkody pośrednie, koszty powstałe w trakcie awarii i transportu.
6. Gwarancja wygasa w przypadku wykonania napraw w nieautoryzowanym serwisie. 

Pierwsze uruchomienie
Telefon należy podłączyć w sposób pokazany na ilustracji w punkcie Podłączanie.

Pierwsza konfiguracja przez telefon
Wymagania:
• wewnętrzny numer telefonu skonfigurowany w centrali telefonicznej
Postępuj zgodnie z instrukcjami w telefonie. 

Wskazówka: MSN to wewnętrzny numer telefonu skonfigurowany w centrali 
telefonicznej.

Konfiguracja przez COMfortel Set
Wymagania:
• zainstalowane oprogramowanie Java Runtime (znajduje się w Internecie)
• zainstalowane oprogramowanie COMfortel Set (znajduje się w Internecie)
• nawiązane połączenie między komputerem a interfejsem komputera w centrali 

telefonicznej (patrz instrukcja centrali telefonicznej)
1. Uruchom program.
2. W menu Options > Interface wybierz używany przez siebie interfejs (np. IP 

network w przypadku połączenia komputera z centralą telefoniczną przez 
sieć lokalną).

3. Kliknij Open > Telephone i wybierz właściwy telefon.
4. Podaj kod PIN.
5. Wybierz preferowane ustawienia.
6. Następnie zapisz konfigurację w telefonie. Kliknij po kolei File > Save > 

Telephone.

Tensione di 
funzionamento

Alimentazione dal centralino tramite porta S0 o UP0 
interna; con COMfortel Xtension300: necessaria 
alimentazione tramite alimentatore a spina; 230 V ~; 
+/- 10%, 50 Hz

Alimentatore a 
spina

Tipo n. FW7577/EU/40

Potenza assorbita Min. 1,1 W, max. 1,9 W; COMfortel Xtension300: 
+0,6 W

Collegamento al 
sistema

Porta S0 o UP0 interna dei centralini: COMpact 3000 
analogico/ISDN/VoIP, COMpact 2206 USB, 
COMpact 4410 USB, COMpact 5010 VoIP, 
COMpact 5020 VoIP, COMpact 4000, 
COMpact 5000/R, COMpact 5200/R, 
COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19", COMmander Business/
19"

Interfaccia PC/
dati

USB

Display 18 LED, 15 dei quali a più colori, display a colori TFT 
da 4,3”, 480 x 272 pixel, retroilluminazione

COMfortel Xtension300: 30 LED, a più colori
Elementi di 
comando

Tastiera, 12 tasti funzione fissi, display a colori con 
funzione touch, tastierino direzionale, 15 tasti 
funzione programmabili con LED (ciascuno con un 
massimo di due funzioni assegnabili su due livelli)

COMfortel Xtension300: 30 tasti funzione 
programmabili

Ricevitore Audio a banda larga, microfono a electret, ricevitore 
con altoparlante dinamico, compatibile con 
apparecchio acustico

Cuffia auricolare Interfaccia separata per cuffie auricolari via cavo, 
anche con supporto della tecnologia wireless 
(DHSG)

Commutatore a 
forchetta

Contatto di commutazione magnetico

Involucro Plastica, nera, bianca
Dimensioni 275 mm x 128/150/170 mm x 210 mm (La x A x P); 

COMfortel Xtension300: 120 x 68/90/110 X 210 
Peso Circa 1050 g; COMfortel Xtension300: circa 310 g
Temperatura Funzionamento: da 0 a 40 °C, stoccaggio: da -30 a 

+70 °C, senza formazione di condensa
Sicurezza CE

Assorbimento di corrente del microfono Max. 0,5 mA
Sensibilità del microfono 45 dB
Impedenza degli altoparlanti 150 Ohm
Sensibilità degli altoparlanti a 1 kHz 19,5 +/- 3 dBPa/V
Limite del livello sonoro 24 dBPa

Bedrijfsspanning Voeding via interne S0- of UP0-poort uit de 
telefooncentrale; met COMfortel Xtension300: 
Voeding via adapter vereist; 230 V ~; +/- 10 %, 
50 Hz

Adapter Type-Nr. FW7577/EU/40
Opgenomen 
vermogen

Min. 1,1 W, max. 1,9 W; COMfortel Xtension300: 
+0,6 W

Systeemaansluiting Interne S0- of UP0-poort van de telefooncentrale: 
COMpact 3000 analog/ISDN/VoIP, COMpact 2206 
USB, COMpact 4410 USB, COMpact 5010 VoIP, 
COMpact 5020 VoIP, COMpact 4000, 
COMpact 5000/R, COMpact 5200/R, 
COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19", COMmander Business/
19"

PC-/data-interface USB
Weergave 18 LEDs, waarvan 15 meerkleurig, 4,3 inch TFT-

kleurendisplay, 480 x 272 pixel, 
achtergrondverlichting

COMfortel Xtension300: 30 LEDs, meerkleurig
Bedieningselementen Toetsenblok, 12 vaste functietoetsen, kleurendisplay 

met touch-functie, besturingspaneel, 15 
programmeerbare functietoetsen met LED (met elk 
tot twee functies die op twee niveaus toewijsbaar 
zijn)

COMfortel Xtension300: 30 programmeerbare 
functietoetsen

Hoorn Wideband audio, elektretmicrofoon, dynamische 
luidspreker handset, compatibel met 
gehoorapparaten

Headset Afzonderlijke interface voor bedrade headsets, ook 
met ondersteuning voor draadloze headsets (DHSG)

Telefoonhaak Magnetisch schakelcontact
Behuizing Kunststof, zwart, wit
Afmetingen 275 mm x 128/150/170 mm x 210 mm (B x H x D); 

COMfortel Xtension300: 120 x 68/90/110 x 210 
Gewicht Ca. 1050 g; COMfortel Xtension300: ca. 310 g
Temperatuur Bedrijf: 0 tot 40 °C, opslag: - 30 tot + 70 °C, niet 

condenserend
Veiligheid CE

Stroomverbruik microfoon Max. 0,5 mA
Gevoeligheid microfoon 45 dB
Impedantie luidspreker 150 Ohm
Gevoeligheid luidspreker bij 1 kHz 19,5 +/- 3 dBPa/V
Grens geluidsniveau 24 dBPa

Napięcie robocze Zasilanie przez wewnętrzny port S0 lub UP0 z centrali 
telefonicznej; z COMfortel Xtension300: konieczne 
zasilanie przez wtykowy zasilacz sieciowy; 230 V ~; 
+/-10%, 50 Hz

Wtykowy zasilacz 
sieciowy

Nr typu FW7577/EU/40

Pobór mocy Min. 1,1 W, maks. 1,9 W; COMfortel Xtension300: 
+0,6 W

Przyłącze 
systemowe

Wewnętrzny port S0 lub UP0 central telefonicznych: 
COMpact 3000 analog/ISDN/VoIP, COMpact 2206 
USB, COMpact 4410 USB, COMpact 5010 VoIP, 
COMpact 5020 VoIP, COMpact 4000, 
COMpact 5000/R, COMpact 5200/R, 
COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19″, COMmander Business/
19″

Złącze 
komputera/
danych

USB

Wskaźniki 18 diod LED, w tym 15 wielokolorowych; wyświetlacz 
kolorowy TFT 4,3 cala, 480 x 272 piksele, 
podświetlenie tła

COMfortel Xtension300: 30 diod LED, 
wielokolorowych

Elementy obsługi Klawiatura przyciskowa, 12 przycisków stałych, 
wyświetlacz kolorowy z obsługą dotykową, 
podkładka kierunkowa, 15 programowalnych 
przycisków funkcji z diodą LED (możliwość 
przypisania maksymalnie dwóch funkcji na dwóch 
poziomach)

COMfortel Xtension300: 30 programowalnych 
przycisków funkcji

Słuchawka Dźwięk szerokopasmowy, mikrofon elektretowy, 
dynamiczny głośnik słuchawki, kompatybilny z 
aparatami słuchowymi

Zestaw 
słuchawkowy

Osobne złącze dla przewodowych zestawów 
słuchawkowych, również z obsługą DHSG

Przełącznik 
aparatowy

Magnetyczny zestyk przełączny

Obudowa Tworzywo sztuczne, czarny, biały
Wymiary 275 mm x 128/150/170 mm x 210 mm (szer. x wys. 

x gł.); COMfortel Xtension300: 120 x 68/90/110 X 
210 

Waga Ok. 1050 g; COMfortel Xtension300: ok. 310 g
Temperatura Eksploatacja: od 0 do 40 °C, przechowywanie: od -

30 do +70 °C, bez kondensacji
Zabezpieczenia CE

Pobór prądu przez mikrofon Maks. 0,5 mA
Czułość mikrofonu 45 dB
Impedancja głośników 150 omów
Czułość głośników przy 1 kHz 19,5 +/- 3 dBPa/V
Granica poziomu dźwięku 24 dBPa
Betriebsanleitung Deutsch
Systemtelefon
Instructions English
System telephone
Manual de instrucciones Español
Teléfono de sistema
Οδηγίες λειτουργίας Ελληνικά
Τηλέφωνο συστήματος
Notice d‘utilisation Français
Téléphone dédié
Istruzioni per l‘uso Italiano
Telefono di sistema
Gebruikshandleiding Nederlands
Systeemtelefoon
Instrukcja obsługi Polski
Telefon systemowy

COMfortel� 2600

Lieferumfang (de) / Scope of delivery (en) / Volumen de suministro (es) 
/ Εξοπλισμός παράδοσης (el) / Contenu de la livraison (fr) / Dotazione 
(it) / Leveringsomvang (nl) / Zakres dostawy (pl)
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*

* Bereits vorinstalliert, siehe Unterseite des Geräts (de)
* Already preinstalled, see underside of the device (en)
* Ya preinstalado, véase la parte inferior del dispositivo (es)
* Αν είναι ήδη προεγκατεστημένο, βλ. στο πίσω μέρος της συσκευής (el)
* Déjà pré-installé, voir le dessous de l’appareil (fr)
* Già preinstallato, vedere la parte inferiore del dispositivo (it)
* Reeds van tevoren geïnstalleerd, zie onderkant van het apparaat (nl)
* Już zainstalowany, patrz spód urządzenia (pl)

Kontaktdaten (de) / Contact data (en) / Datos de contacto (es) / Στοιχεία 
επικοινωνίας (el) / Coordonnées (fr) / Dati di contatto (it) / Contactge-
gevens (nl) / Dane połączeń (pl)
Hersteller/Manufacturer: Auerswald GmbH & Co. KG, Hordorfer Str. 36, 
D-38162 Cremlingen

D A CH L
www.auerswald.de

B E F GB GR I NL PL
www.fontevo.com

Copyright
� Auerswald GmbH & Co. KG, D-38162 Cremlingen, 2017

Trademarks
Microsoft and Windows are registered trademarks of the Microsoft Corporation in the U.S.A. and/or other coun-
tries. Bitstream Vera Font � 2003 Bitstream, Inc. All rights reserved. Bitstream Vera is a trademark of Bitstream, 
Inc.. Arev Font � Tavmjong Bah. All rights reserved. All other trademarks mentioned are the property of the cor-
responding manufacturer. This product contains software which is based in part on the work of the Independent 
JPEG Group.

Licenses
The software included in this product contains also copyrighted software that is licenced under various licences. A copy of these licences is included in this document.

Apache License
Version 2.0, January 2004
Android Ring Tones: Copyright (c) 2009 Android Open Source Project 
Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://www.apache.org/licenses/
LICENSE-2.0
Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express 
or implied. See the License for the specific language governing permissions and limitations under the License.

BSD License
Newlib sources licensed using BSD 3-clause license: Sources from the following contributors in the newlib subdirecory are licensed using the BSD 3-clause license:
(2) University of California, Berkeley. Copyright (c) 1981-2000 The Regents of the University of California. All rights reserved.
(11) Christopher G. Demetriou. Copyright (c) 2001 Christopher G. Demetriou. All rights reserved.
(13) Royal Institute of Technology. Copyright (c) 1999 Kungliga Tekniska Högskolan (Royal Institute of Technology, Stockholm, Sweden). All rights reserved.
(19) Todd C. Miller. Copyright (c) 1998 Todd C. Miller <Todd.Miller@courtesan.com>. All rights reserved.
(35) - ARM Ltd (arm and thumb variant targets only). Copyright (c) 2009 ARM Ltd. All rights reserved.
The BSD 3-clause license: Copyright (c) <YEAR>, <OWNER> All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the <ORGANIZATION> nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Newlib sources licensed using BSD 2-clause license: Sources from the following contributors in the newlib subdirecory are licensed using the BSD 2-clause license:
(14) Alexey Zelkin. Copyright (c) 2000, 2001 Alexey Zelkin <phantom@FreeBSD.org>. All rights reserved.
(15) Andrey A. Chernov. Copyright (C) 1997 by Andrey A. Chernov, Moscow, Russia. All rights reserved.
(16) FreeBSD. Copyright (c) 1997-2002 FreeBSD Project. All rights reserved.
(18) Citrus Project. Copyright (c)1999 Citrus Project. All rights reserved.
(27) Konstantin Chuguev (--enable-newlib-iconv). Copyright (c) 1999, 2000 Konstantin Chuguev.  All rights reserved.
(28) Artem Bityuckiy (--enable-newlib-iconv). Copyright (c) 2003, Artem B. Bityuckiy, SoftMine Corporation. Rights transferred to Franklin Electronic Publishers.
(26) Mike Barcroft. Copyright (c) 2001 Mike Barcroft <mike@FreeBSD.org>. All rights reserved.
(30) - Alex Tatmanjants (targets using libc/posix). Copyright (c) 1995 Alex Tatmanjants <alex@elvisti.kiev.ua> at Electronni Visti IA, Kiev, Ukraine. All rights reserved.
(31) - M. Warner Losh (targets using libc/posix). Copyright (c) 1998, M. Warner Losh <imp@freebsd.org>. All rights reserved.
(32) - Andrey A. Chernov (targets using libc/posix). Copyright (C) 1996 by Andrey A. Chernov, Moscow, Russia. All rights reserved.
(33) - Daniel Eischen (targets using libc/posix). Copyright (c) 2001 Daniel Eischen <deischen@FreeBSD.org>. All rights reserved.
The BSD 2-clause license: Copyright (c) <YEAR>, <OWNER> All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Deja Vu License
Fonts are © Bitstream (see below). DejaVu changes are in public domain. Explanation of copyright is on Gnome page on Bitstream Vera fonts. Glyphs imported from Arev fonts are © Tavmjung Bah (see below) 
Bitstream Vera Fonts Copyright: Copyright (c) 2003 by Bitstream, Inc. All Rights Reserved. Bitstream Vera is a trademark of Bitstream, Inc.
Permission is hereby granted, free of charge, to any person obtaining a copy of the fonts accompanying this license ("Fonts") and associated documentation files (the "Font Software"), to reproduce and dis-
tribute the Font Software, including without limitation the rights to use, copy, merge, publish, distribute, and/or sell copies of the Font Software, and to permit persons to whom the Font Software is furnished 
to do so, subject to the following conditions:
The above copyright and trademark notices and this permission notice shall be included in all copies of one or more of the Font Software typefaces.
The Font Software may be modified, altered, or added to, and in particular the designs of glyphs or characters in the Fonts may be modified and additional glyphs or characters may be added to the Fonts, 
only if the fonts are renamed to names not containing either the words "Bitstream" or the word "Vera".
This License becomes null and void to the extent applicable to Fonts or Font Software that has been modified and is distributed under the "Bitstream Vera" names.
The Font Software may be sold as part of a larger software package but no copy of one or more of the Font Software typefaces may be sold by itself.
THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL BITSTREAM OR THE GNOME FOUNDATION BE LIA-
BLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN ACTION OF CON-
TRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE FONT SOFTWARE.
Except as contained in this notice, the names of Gnome, the Gnome Foundation, and Bitstream Inc., shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Font Software 
without prior written authorization from the Gnome Foundation or Bitstream Inc., respectively. For further information, contact: fonts at gnome dot org. 
Arev Fonts Copyright : Copyright (c) 2006 by Tavmjong Bah. All Rights Reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of the fonts accompanying this license ("Fonts") and associated documentation files (the "Font Software"), to reproduce and dis-
tribute the modifications to the Bitstream Vera Font Software, including without limitation the rights to use, copy, merge, publish, distribute, and/or sell copies of the Font Software, and to permit persons to 
whom the Font Software is furnished to do so, subject to the following conditions:
The above copyright and trademark notices and this permission notice shall be included in all copies of one or more of the Font Software typefaces.
The Font Software may be modified, altered, or added to, and in particular the designs of glyphs or characters in the Fonts may be modified and additional glyphs or characters may be added to the Fonts, 
only if the fonts are renamed to names not containing either the words "Tavmjong Bah" or the word "Arev".
This License becomes null and void to the extent applicable to Fonts or Font Software that has been modified and is distributed under the "Tavmjong Bah Arev" names.
The Font Software may be sold as part of a larger software package but no copy of one or more of the Font Software typefaces may be sold by itself.
THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL TAVMJONG BAH BE LIABLE FOR ANY CLAIM, DAM-
AGES OR OTHER LIABILITY, INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE FONT SOFTWARE.
Except as contained in this notice, the name of Tavmjong Bah shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Font Software without prior written authorization 
from Tavmjong Bah. For further information, contact: tavmjong @ free . fr. 

Freetype2-Library
Freetype credits: Portions of this software are copyright © 2014 The FreeType Project (www.freetype.org). All rights reserved. 

JPEG License
This software is based in part on the work of the Independent JPEG Group.

Newlib License
The newlib subdirectory is a collection of software from several sources. Each file may have its own copyright/license that is embedded in the source file. Unless otherwise noted in the body of the source 
file(s), the following copyright notices will apply to the contents of the newlib subdirectory:
(1) Red Hat Incorporated. Copyright (c) 1994-2009  Red Hat, Inc. All rights reserved.
This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it subject to the terms and conditions of the BSD License. This program is distributed in the hope that it will 
be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at 
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or documentation are not subject to the BSD License and may only be used or replicated with the express 
permission of Red Hat, Inc.
The author of this software is David M. Gay.
Copyright (C) 1998-2001 by Lucent Technologies. All Rights Reserved
Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that 
both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity 
pertaining to distribution of the software without specific, written prior permission.
LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR 
ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
(3) David M. Gay (AT&T 1991, Lucent 1998). The author of this software is David M. Gay. Copyright (c) 1991 by AT&T.
Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy 
or modification of this software and in all copies of the supporting documentation for such software.
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.  IN PARTICULAR,  THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND 
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.
(4) Advanced Micro Devices. Copyright 1989, 1990 Advanced Micro Devices, Inc.
This software is the property of Advanced Micro Devices, Inc  (AMD)  which specifically  grants the user the right to modify, use and distribute this software provided this notice is not removed or altered. All 
other rights are reserved by AMD.
AMD MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS SOFTWARE.  IN NO EVENT SHALL AMD BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES 
IN CONNECTION WITH OR ARISING FROM THE FURNISHING, PERFORMANCE, OR USE OF THIS SOFTWARE.
So that all may benefit from your experience, please report  any  problems or  suggestions about this software to the 29K Technical Support Center at 800-29-29-AMD (800-292-9263) in the USA, or 0800-89-
1131  in  the  UK,  or 0031-11-1129 in Japan, toll free.  The direct dial number is 512-462-4118.
Advanced Micro Devices, Inc., 29K Support Products, Mail Stop 573, 5900 E. Ben White Blvd., Austin, TX 78741, 800-292-9263
(7) Sun Microsystems. Copyright (c) 1993 by Sun Microsystems, Inc. All rights reserved.
Developed at SunPro, a Sun Microsystems, Inc. business.
Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is preserved.
(8) Hewlett Packard. (c) Copyright 1986 HEWLETT-PACKARD COMPANY
To anyone who acknowledges that this file is provided "AS IS" without any express or implied warranty: permission to use, copy, modify, and distribute this file for any purpose is hereby granted without fee, 
provided that the above copyright notice and this notice appears in all copies, and that the name of Hewlett-Packard Company not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose.
(9) Hans-Peter Nilsson. Copyright (C) 2001 Hans-Peter Nilsson
Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy 
or modification of this software and in all copies of the supporting documentation for such software.
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.  IN PARTICULAR,  THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND 
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.
(17) S. L. Moshier. Author:  S. L. Moshier. Copyright (c) 1984,2000 S.L. Moshier
Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy 
or modification of this software and in all copies of the supporting documentation for such software.
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.  IN PARTICULAR,  THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND 
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.



Deutsch
Wichtige Informationen

Sicherheitshinweise
Warnung: Unsachgemäßer Umgang mit dem Gerät kann zu einem 
lebensgefährlichen elektrischen Schlag führen und das Gerät 
beschädigen oder zerstören.

•   Lesen Sie die zum Gerät gehörenden Anleitungen und bewahren Sie 
diese auf.

•   Schließen Sie die Anschlusskabel des Geräts nur an die dafür bestimm-
ten und fachgerecht installierten Anschlussdosen an

•   Verwenden Sie ausschließlich Originalzubehör und Originalersatzteile.

Warnung: Unvollständige oder fehlerhafte Einrichtung kann zur 
Gefährdung von Personen führen, z. B. aufgrund nicht durchführba-
rer Notrufe.

•   Die Einrichtung des Produkts erfolgt über das Telefon oder über die Soft-
ware COMfortel Set. Die zugehörige Hilfe ist in englischer oder deutscher 
Sprache vorhanden. Wenn Sie mit diesen Sprachen und den verwende-
ten Fachbegriffen nicht vertraut sind, ziehen Sie eine fachlich und 
sprachlich geeignete Fachkraft hinzu.

Warnung: Die Verwendung des falschen Steckernetzteils kann zu 
einem lebensgefährlichen elektrischen Schlag führen und das Tele-
fon beschädigen oder zerstören.

•   Verwenden Sie nur das Steckernetzteil Typ-Nr. FW7577/EU/40.

Warnung: In das Gehäuse eindringende Flüssigkeiten können zu 
einem lebensgefährlichen elektrischen Schlag führen und das Gerät 
beschädigen oder zerstören.

•   Betreiben Sie das Telefon nur in geschlossenen, trockenen Räumen.
•   Reinigen Sie das Gerät nur mit einem leicht feuchten Tuch oder einem 

Antistatiktuch.

Warnung: Beschädigte Anschlussleitungen sowie Beschädigungen 
am Gehäuse und am Gerät selbst können zu einem lebensgefährli-
chen elektrischen Schlag führen.

•   Nehmen Sie ein beschädigtes Gerät nicht in Betrieb.

Warnung: Überspannungen, wie sie bei Gewitter auftreten, können 
zu einem lebensgefährlichen elektrischen Schlag führen oder das 
Gerät beschädigen oder zerstören.

•   Verzichten Sie während eines Gewitters auf das Berühren des Gerätes.
•   Lassen Sie von einer Elektrofachkraft alle Kabel innerhalb des Gebäudes 

verlegen.

Warnung: Ungeeignete Headsets, externe Lautsprecher oder Hörer 
können zu Gehörschäden führen oder die Sprachverbindung stören.

•   Beachten Sie die technischen Daten zum Anschluss eines Headsets.

Warnung: Durch das schwache Magnetfeld im Hörer angezogene 
Objekte wie Nadeln und Büroklammern können zu Verletzungen füh-
ren.

•   Legen Sie den Hörer nicht in die Nähe solcher Objekte.

Warnung: Erstickungsgefahr. Das Gerät enthält Kleinteile, die von 
Kleinkindern verschluckt werden können.

•   Halten Sie das Gerät außerhalb der Reichweite von Kleinkindern

Wichtig: Das Gerät ist nicht dafür ausgelegt und sollte daher nicht für 
lebenserhaltende Systeme und/oder Anwendungen innerhalb nuklearer 
Einrichtungen eingesetzt werden. Einem Einsatz des Geräts für solche 
Anwendungen muss zwingend eine auf den Einzelfall zugeschnittene 
schriftliche Zustimmung/Erklärung des Herstellers vorausgehen
Nicht bestimmungsgemäße Verwendung kann z. B. zu Funktionseinschrän-
kungen oder Störungen, zur Zerstörung des Geräts oder schlimmstenfalls 
zur Gefährdung von Personen führen.
•   Wenn Sie sich über die bestimmungsgemäße Verwendung auch nach 

dem Lesen des folgenden Kapitels nicht sicher sind, fragen Sie Ihren 
Fachhändler.

•   Lesen Sie die zum Gerät gehörenden Anleitungen und bewahren Sie 
diese zum späteren Gebrauch auf.

•   Für die Nutzung einiger Funktionen ist eine Freischaltung beim Netzbe-
treiber, ein Firmware-Update und/oder eine Einrichtung über COMfortel 
Set notwendig. 

Bestimmungsgemäße Verwendung
Systemtelefon zum Anschluss an den internen S0- oder UP0-Port einer 
TK-Anlage von Auerswald/FONtevo (siehe Technische Daten). Der 
Anschluss an eine TK-Anlage eines anderen Herstellers oder an den exter-
nen S0-Anschluss eines Netzbetreibers ist nicht vorgesehen. Das Telefon 
ist kabelgebunden und für den Betrieb in geschlossenen, trockenen Räu-
men vorgesehen.

Technische Daten

Technische Daten für den Anschluss eines Headsets

Umwelthinweise
Sollte das Gerät einmal ausgedient haben, achten Sie auf die fachgerechte 
Entsorgung (nicht in den normalen Hausmüll).

Entsorgen Sie das Verpackungsmaterial im Interesse des Umwelt-
schutzes ordnungsgemäß.

Erkundigen Sie sich bei der Stadt- oder Gemeindeverwaltung nach 
Möglichkeiten einer umwelt- und sachgerechten Entsorgung des 
Geräts. Wenn Sie möchten, dass wir Ihnen die Entsorgung abneh-
men, senden Sie das Gerät auf Ihre Kosten an die Auerswald GmbH 

& Co. KG.

Betriebsspannung Versorgung über internen S0- oder UP0-Port aus der 
TK-Anlage; mit COMfortel Xtension300: Versorgung 
über Steckernetzteil notwendig; 230 V ~; +/- 10 %, 
50 Hz

Steckernetzteil Typ-Nr. FW7577/EU/40
Leistungsauf-
nahme

Min. 1,1 W, max. 1,9 W; COMfortel Xtension300: 
+0,6 W

Systemanschluss Interner S0- oder UP0-Port der TK-Anlagen: 
COMpact 3000 analog/ISDN/VoIP, COMpact 2206 
USB, COMpact 4410 USB, COMpact 5010 VoIP, 
COMpact 5020 VoIP, COMpact 4000, 
COMpact 5000/R, COMpact 5200/R, 
COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19", COMmander Business/
19"

PC-/Datenschnitt-
stelle

USB

Anzeigen 18 LEDs, 15 davon mehrfarbig, 4,3 Zoll-TFT-Farb-
display, 480 x 272 Pixel, Hintergrundbeleuchtung

COMfortel Xtension300: 30 LEDs, mehrfarbig
Bedienelemente Wähltastatur, 12 Festfunktionstasten, Farbdisplay 

mit Touch-Funktion, Steuerkreuz, 15 programmier-
bare Funktionstasten mit LED (mit jeweils bis zu zwei 
Funktionen auf zwei Ebenen belegbar)

COMfortel Xtension300: 30 programmierbare Funk-
tionstasten

Hörer Wideband Audio, Elektret-Mikrofon, dynamischer 
Hörerlautsprecher, hörgerätekompatibel

Headset Separate Schnittstelle für kabelgebundene Head-
sets, auch mit DHSG-Unterstützung

Gabelumschalter Magnetischer Schaltkontakt
Gehäuse Kunststoff, schwarz, weiß
Abmessungen 275 mm x 128/150/170 mm x 210 mm (B x H x T); 

COMfortel Xtension300: 120 x 68/90/110 X 210 
Gewicht Ca. 1050 g; COMfortel Xtension300: ca. 310 g
Temperatur Betrieb: 0 bis 40 °C, Lagerung: - 30 bis + 70 °C, nicht 

kondensierend
Sicherheit CE

Stromaufnahme Mikrofon Max. 0,5 mA
Empfindlichkeit Mikrofon 45 dB
Impedanz Lautsprecher 150 Ohm
Empfindlichkeit Lautsprecher bei 1 kHz 19,5 +/- 3 dBPa/V
Schallpegelgrenze 24 dBPa
Konformitätserklärung
Dieses Gerät entspricht den grundlegenden Gesundheits-, Sicherheits- und 
Umweltanforderungen aller relevanten europäischen Richtlinien. Die Konformi-
tätserklärung kann im Internet eingesehen werden.

Anleitungen
Die Anleitung „Erweiterte Informationen“ finden Sie im COMfortel Set und im Internet. Die Kurzanleitung finden Sie im Inter-
net. Nach einem Firmware-Update benötigen Sie ggf. aktualisierte Anleitungen. Diese finden Sie im Internet.

Garantiebedingungen
1. Die Auerswald GmbH & Co. KG, Vor den Grashöfen 1, D-38162 Cremlingen, gewährt als Hersteller auf dieses Produkt 
24 Monate Herstellergarantie ab Kaufdatum.
2. Dies bedeutet für Sie als Verbraucher: Wir garantieren, dass unsere Geräte bei der Übergabe fehlerfrei sind und sorgen 
24 Monate ab diesem Datum für eine kostenlose Reparatur oder liefern kostenfrei Ersatz, falls ein Herstellungsfehler auftritt 
und verzichten auf den durch Sie als Verbraucher zu führenden Nachweis wie bei der gesetzlichen Gewährleistung, dass 
dieser Fehler zum Zeitpunkt der Übergabe schon vorhanden war. Bei der Reparatur oder der Ersatzlieferung verwenden 
wir entweder neue oder neuwertige Teile. Dem Gerät evtl. entnommene Teile gehen in unser Eigentum über und dürfen 
vernichtet werden.
3. Neben dieser Garantie stehen dem Kunden in vollem Umfang die gesetzlichen Rechte aus der Mängelgewährleistung 
auf der Grundlage des Kaufvertrages gegenüber dem Lieferanten zu. Die gesetzliche Mängelgewährleistung betrifft aber 
im Gegensatz zu unserer Herstellergarantie nur die Beschaffenheit zum Zeitpunkt des Verkaufs (Übergabe). 
4. Sie können diese Garantie nur in Anspruch nehmen, wenn Sie das fehlerhafte Gerät mit einem eindeutigen Kaufbeleg 
(Rechnung oder Kassenbeleg) auf Ihre Kosten an die Auerswald GmbH & Co. KG bzw. außerhalb Deutschlands an unse-
ren Generalimporteur oder Distributor vor Ort einsenden. Fügen Sie dieser Einsendung bitte eine ausführliche Fehlerbe-
schreibung bei und geben Sie bitte auch für eventuelle Nachfragen Ihre Telefonnummer an. Um Transportschäden zu ver-
meiden, sorgen Sie bitte für eine geeignete Transportverpackung (z. B. Originalverpackung mit Umkarton).
5. Ausgeschlossen von der Herstellergarantie sind Schäden, die durch unsachgemäße Behandlung, Bedienungsfehler, 
Missbrauch, äußere Einflüsse, Blitzschlag/Überspannung, Veränderungen des Produkts sowie Anbauten entstehen. Des 
Weiteren ausgeschlossen sind Verschleißteile (z. B. Batterien, Sicherungen, Akkus, Speicherkarten), sowie durch Ver-
schleißteile entstandene Schäden (z. B. durch das Auslaufen von Batterien). Ebenfalls ausgeschlossen sind Transport-
schäden, Folgeschäden, Kosten für Ausfall- und Wegezeiten.
6. Die Garantie erlischt bei Reparaturen durch nicht autorisierte Stellen. 

Erstinbetriebnahme
Schließen Sie das Telefon wie auf der Abbildung unter Anschluss gezeigt an.

Ersteinrichtung über das Telefon
Voraussetzungen:
• An der TK-Anlage eingerichtete interne Rufnummer
Folgen Sie den Anweisungen im Telefon. 

Hinweis: Die MSN ist die in der TK-Anlage eingerichtete interne Rufnummer.

Einrichtung über COMfortel Set
Voraussetzungen:
• Java Runtime installiert (finden Sie im Internet)
• COMfortel Set installiert (finden Sie im Internet)
• Bestehende Verbindung des PCs zu einer PC-Schnittstelle der TK-Anlage 

(siehe Anleitung der TK-Anlage)
1. Starten Sie das Programm.
2. Wählen Sie unter Optionen > Schnittstelle die von Ihnen verwendete 

Schnittstelle aus (z. B. IP-Netzwerk bei Verbindung des PCs mit der TK-An-
lage über das lokale Netzwerk).

3. Klicken Sie auf Öffnen > Telefon und wählen Sie das betreffende Telefon 
aus.

4. Geben Sie die PIN ein.
5. Nehmen Sie die gewünschten Einstellungen vor.
6. Sichern Sie die Konfiguration anschließend in das Telefon. Klicken Sie dazu 

nacheinander auf Datei > Speichern > Telefon.

English
Important Information

Safety information
Warning: Handling the device improperly can cause a life-threatening 
electrical shock, or damage or destroy the device.

•   Read the instructions for the device and keep them for future reference.
•   Only connect the device's connection cables to wall sockets that are designed 

for that purpose, and that have been properly installed.
•   Only use original accessories and original replacement parts.

Warning: Incomplete or incorrect configuration can create a personal 
hazard e.g. because emergency calls cannot be made.

•   The product is configured using the telephone or the COMfortel Set software. 
The associated help is provided in English or German. If you are not familiar 
with these languages, and the technical terms that are used, seek support from 
someone who has the necessary technical and language skills.

Warning: Using the wrong wall-mounted power supply can result in life-
threatening electrical shock, or damage or destroy the telephone.

•   For this reason, only use a wall-mounted power supply of type no. FW7577/EU/
40.

Warning: Any liquid that penetrates the casing can result in a life-
threatening electric shock or can damage or destroy the telephone.

•   Only operate the telephone in closed, dry rooms.
•   Only clean the device with a soft damp cloth or an anti-static cloth.

Warning: Damaged connecting cables, or damage to the casing or the 
device, can cause life-threatening electrical shocks.

•   Never use a damaged device.

Warning: Power surges, which can occur during electrical storms, can 
cause life-threatening electric shocks or damage/destroy the device.

•   Do not touch the device during an electrical storm.
•   Arrange for a qualified electrician to install all the cables inside the building.

Warning: Non-approved headsets, external loudspeakers, or receivers, 
may cause hearing damage or interfere with the voice connection.

•   Note the technical information about connecting a headset.

Warning: Objects attracted by the weak magnetic field in the receiver, such 
as needles and paper clips, can cause injuries.

•   To avoid injuries, do not put the receiver down close to such objects.

Warning: Danger of suffocation. The device contains small parts which 
infants or small children might swallow.

•   Keep the device out of reach of children.

Important: The device is not designed or intended for use in life-support systems 
and/or nuclear facilities. Our products can only be used for these purposes with 
prior written permission/clarification from Auerswald in each individual case.
Improper use may, for example, cause functional restrictions or malfunctions, the 
destruction of the device or, in a worst case scenario, personal injury.
•   If you are still uncertain about how to use the product properly after reading the 

section below, please contact your specialised dealer.
•   Read the instructions for the device and keep them for future reference.
•   Some of the functions require activation by the network provider, a firmware 

update and/or configuration via COMfortel Set. 

Proper use
System telephone for connection to the internal S0 or UP0 port on a PBX supplied 
by Auerswald/FONtevo (see Technical Data). There is no provision for connecting 
to another manufacturer's PBX or to a network provider's external S0 connection. 
The telephone is corded, and is intended for use in closed, dry rooms.

Technical Data

Technical Data for Headset Connections

Environmental Notices
If the Auerswald device is taken out of use (retired), make sure that it is properly 
disposed of (it must not be disposed of with normal household waste).

To protect the environment, please make sure that the packaging materials 
are properly disposed of.

Consult your local governmental authorities for information about how to 
dispose of the device in a proper and environmentally safe way. If you would 
like us to handle disposal, please send the device to us, at Auerswald GmbH 
& Co. KG.

Declaration of Conformity
This device complies with the basic health, safety and environmental requirements 
in all relevant EU directives. You can view the Declaration of Conformity in the 
Internet.

Instructions
You will find the "Additional Information" instructions in the COMfortel Set software and in the Internet. You will find the 
Quick Guide in the Internet. After a firmware update you usually require a new version of the instructions. You will find 
this in the Internet.

Conditions of Guarantee
1. Auerswald GmbH & Co. KG, Vor den Grashöfen 1, D-38162 Cremlingen, grants 24 months Manufacturer's Warranty from 
the date of purchase, as the manufacturer of this product.
2. For you, as a consumer, this means: We guarantee that our devices are error-free when supplied. If a manufacturing 
error is identified within 24 months of the delivery date we will repair or replace the device free of charge without you, as 
the consumer, having to provide the usual legally required proof that this fault was present when you received the device. 
We either use new parts or parts in mint condition for the repair or replacement delivery. Any parts removed from the device 
become our property and can be destroyed by us.
3. In addition to this warranty, you have the unlimited legal right to claim against the supplier on the basis of the terms of 
the warranty for defects on the basis of the purchase contract. However, in contrast to our Manufacturer's Warranty, the 
legal warranty for defects only applies to the device's state when sold (handover). 
4. You can only claim against this warranty if you return the faulty device to Auerswald GmbH & Co. KG or our local general 
importer or distributor, outside Germany, at your own cost, with a valid proof of purchase (invoice or till receipt). When you 
return it to us, please provide a detailed description of the fault that has occurred, and also tell us your telephone number, 
in case we need to contact you. To prevent shipping damage, provide suitable transport packaging (e.g. original packaging 
with a secondary shipping box).
5. The Manufacturer's Warranty excludes damage caused by mishandling, operating errors, misuse, external influences, 
lightning strikes/power surges, modifications to the product and extensions. Also excluded are wearing parts (e.g. batteries, 
fuses, rechargeable batteries and memory cards) and damage caused by wearing parts (e.g. if batteries go flat). Shipping 
damage, consequential damage, and costs arising from down times and travel times are also excluded.
6. The warranty is cancelled if repairs are carried out by unauthorised agents. 

Initial Commissioning
Connect the telephone as shown in the figure under Connection.

Initial setup using the telephone
Requirements:
• Internal telephone numbers configured on the PBX
Follow the instructions on the telephone. 

Note: The MSN is the internal number that has been set up on the PBX.

Configuration via COMfortel Set
Requirements:
• Java Runtime is installed (you can find it in the Internet)
• COMfortel Set is installed (you can find it in the Internet)
• Existing PC connection to a PC interface on the PBX (see the PBX manual)
1. Run the program.
2. Select Options > Interface and then select the interface you are using (for 

example, IP network, to connect the PC to the PBX over the local network).
3. Click Open > Telephone and select the required telephone.
4. Enter the required PIN.
5. Configure the settings you want.
6. Now save the configuration in the telephone. Click File > Save > Telephone.

Español
Información importante

Indicaciones de seguridad
Advertencia: Si este dispositivo se utiliza de forma indebida se corre el 
riesgo de provocar una descarga eléctrica potencialmente mortal y daños 
en el dispositivo o su destrucción.

•   Debe leer las instrucciones correspondientes al dispositivo y guardarlas.
•   Los cables de conexión del dispositivo deben conectarse únicamente a las 

cajas de conexión instaladas específicamente para ellos
•   Utilice exclusivamente repuestos y accesorios originales.

Advertencia: La configuración incompleta o errónea del sistema puede 
poner en riesgo a las personas, como en el caso de que no se puedan 
realizar llamadas de emergencia.

•   La configuración del producto se efectúa a través del teléfono o del software 
COMfortel Set. La ayuda correspondiente está disponible en inglés y en 
alemán. Si no tiene un dominio suficiente de estos idiomas ni de la terminología 
técnica solicite ayuda a un profesional técnico que conozca dichos idiomas.

Advertencia: Si se utiliza un transformador de enchufe incorrecto se corre 
el riesgo de provocar una descarga eléctrica potencialmente mortal y daños 
en el teléfono o su destrucción.

•   Utilice solo el transformador de enchufe del modelo n.º FW7577/EU/40.

Advertencia: La penetración de líquidos en el interior de la carcasa puede 
provocar una descarga eléctrica potencialmente mortal y dañar o destruir el 
dispositivo.

•   El teléfono solamente puede funcionar en espacios cerrados y secos.
•   Para limpiar el dispositivo utilice únicamente un paño humedecido o un paño 

especial antiestático.

Advertencia: Las líneas de conexión dañadas, así como los daños o 
desperfectos en la carcasa o el propio dispositivo, pueden provocar 
descargas eléctricas potencialmente mortales.

•   Jamás debe encender un dispositivo averiado o dañado para hacerlo 
funcionar.

Advertencia: Las sobretensiones, como las que pueden producirse en 
caso de tormenta eléctrica, pueden provocar descargas eléctricas 
potencialmente mortales y dañar o destruir el dispositivo.

•   No toque el dispositivo durante una tormenta eléctrica.
•   Debe encargar a un electricista el tendido de todos los cables en el interior del 

edificio.

Advertencia: El uso de auriculares, altavoces externos o microteléfonos 
inadecuados puede provocar daños en el oído o dificultar la comunicación.

•   Consulte los datos técnicos antes de conectar unos auriculares.

Advertencia: El campo magnético de baja intensidad del microteléfono 
puede atraer objetos de oficina como chinchetas o clips que pueden 
provocar lesiones.

•   No deje el microteléfono cerca de dichos objetos.

Advertencia: Peligro de asfixia. Este dispositivo contiene piezas pequeñas 
que podrían ser ingeridas por niños pequeños.

•   Mantenga el dispositivo fuera del alcance de los niños pequeños

Importante: Este dispositivo no se ha concebido para trabajar con sistemas de 
soporte vital o aplicaciones relacionadas con instalaciones nucleares, por lo que 
no se debe utilizar para tales fines. Si se pretende utilizar este dispositivo para 
finalidades de esa naturaleza, es obligatorio contar con una autorización o 
aprobación previa por escrito del fabricante que se adapte a las características 
concretas del caso
Utilizar este dispositivo para fines distintos de los previstos podría conllevar 
limitaciones de su funcionamiento o averías y destruir el dispositivo o, en el peor 
de los casos, comportar riesgos para la seguridad de las personas.
•   Si después de leer el siguiente capítulo le quedan dudas sobre el uso adecuado 

y previsto del dispositivo consulte a su distribuidor especializado.
•   Debe leer las instrucciones correspondientes al dispositivo y guardarlas para 

poderlas consultar posteriormente.
•   Para usar algunas funciones es preciso efectuar una activación en el operador 

de red, una actualización del firmware y/o ejecutar una configuración con el 
software COMfortel Set. 

Uso previsto
Teléfono de sistema para conexión al puerto interno S0 o UP0 de una centralita de 
Auerswald/FONtevo (ver datos técnicos). No está prevista la conexión a una 
centralita de otro fabricante ni a la conexión externa S0 de un operador de red. El 
teléfono tiene cable y está previsto para funcionar en espacios cerrados y secos.

Datos técnicos

Datos técnicos para la conexión de auriculares

Indicaciones relativas al medio ambiente
Si el dispositivo se queda anticuado o finaliza su cometido, debe tener en cuenta 
las normas específicas para la eliminación del mismo (no se debe desechar junto 
con la basura doméstica).

Elimine el material de embalaje conforme a las normas de protección del 
medio ambiente.

Consulte al órgano de administración municipal cuáles son las posibilidades 
para desechar el dispositivo de una forma adecuada y respetuosa con el 
medio ambiente. Si lo desea, nosotros podemos hacernos cargo de la 

eliminación. En tal caso, envíe el dispositivo a Auerswald GmbH & Co KG. Deberá 
correr con los gastos de envío pertinentes.

Declaración de conformidad
Este dispositivo cumple con los requisitos esenciales sobre salud, seguridad y 
medio ambiente de todas las directivas europeas pertinentes. La declaración de 
conformidad se puede consultar en Internet.

Instrucciones
Encontrará las instrucciones del apartado "Más información" en COMfortel Set y en Internet. En Internet encontrará la Guía 
rápida. Después de efectuar una actualización del firmware es posible que necesite descargar una copia actualizada de 
las instrucciones. La encontrará en Internet.

Condiciones de la garantía
1. La empresa Auerswald GmbH & Co. KG, con sede en Vor den Grashöfen 1, D-38162 Cremlingen (Alemania), como 
fabricante de este producto, ofrece una garantía de fabricante por un plazo de 24 meses, contados desde la fecha de 
compra.
2. Para usted, como consumidor, esto implica que: Le garantizamos que nuestros dispositivos están en perfecto estado de 
funcionamiento en el momento de la entrega. Durante un plazo de 24 meses a partir de esa fecha, en caso de defectos de 
fabricación, le proporcionaremos un servicio de reparación totalmente gratuito o le facilitaremos un aparato de sustitución 
sin coste. A diferencia de las condiciones de la garantía legal obligatoria, usted no tendrá que demostrar que el problema 
o la avería ya existía en el momento de la entrega de la centralita. En caso de que sea preciso realizar reparaciones o 
entregarle un dispositivo de sustitución, utilizaremos componentes nuevos o en perfecto estado. Los componentes que 
pudieran extraerse del dispositivo pasarán a ser de nuestra propiedad, estando permitida su destrucción.
3. Además de esta garantía, el cliente cuenta con todos los derechos legales derivados de la garantía contra defectos 
impuesta por ley, que descansan sobre el contrato de compraventa y cuyas responsabilidades recaen sobre el proveedor. 
A diferencia de nuestra garantía de fabricante, la garantía legal contra defectos solamente cubre las condiciones del 
producto en el momento de la venta (entrega). 
4. Solamente podrá efectuar reclamaciones al amparo de esta garantía si acompaña el dispositivo defectuoso de un 
documento que acredite con claridad la adquisición (factura o recibo de compra), que debe presentar corriendo usted con 
los correspondientes gastos ante Auerswald GmbH & Co. KG o, en caso de encontrarse fuera de Alemania, ante nuestro 
importador general o distribuidor local. Le rogamos que, junto con el dispositivo y la documentación acreditativa de la 
compra, incluya una descripción detallada del problema y nos facilite asimismo un número de teléfono para poder 
plantearle las preguntas que pudiesen surgir. Para evitar que el dispositivo sufra daños durante el transporte, le 
aconsejamos que procure emplear un embalaje apropiado para ello (por ejemplo, el embalaje original dentro de una caja 
protectora).
5. Quedan excluidos de la garantía del fabricante los daños causados por manipulación inadecuada, errores de manejo, 
usos indebidos, factores externos, sobretensiones o impactos de rayos, alteraciones del producto o accesorios 
complementarios incorporados. Quedan asimismo excluidos de la garantía los componentes sometidos a desgaste (por 
ejemplo: pilas, fusibles, baterías, tarjetas de memoria) y los daños provocados por componentes sometidos a desgaste 
(por ejemplo, por pilas agotadas). También quedan excluidos de la garantía los daños ocurridos durante el transporte, los 
daños indirectos y los costes por interrupciones del servicio y tiempos de los traslados.
6. La garantía se considerará extinguida si se efectúan reparaciones en talleres no autorizados. 

Entrada en servicio
Realice las conexiones del teléfono como se muestra en la figura titulada 
"Conexión".

Configuración inicial a través del teléfono
Requisitos:
• Número interno configurado en la centralita
Siga las instrucciones del teléfono. 

Nota: El MSN es el número interno configurado en la centralita.

Configuración a través COMfortel Set
Requisitos:
• Java Runtime instalado (lo encontrará en Internet)
• COMfortel Set instalado (lo encontrará en Internet)
• Conexión establecida entre el PC y una interfaz PC de la centralita (véanse las 

instrucciones de la centralita)
1. Inicie el programa.
2. En Opciones > Interfaz seleccione la interfaz que utiliza (p. ej. Red IP para 

la conexión del PC con la centralita a través de la red local).
3. Haga clic en Abrir > Teléfono y seleccione el teléfono que corresponda.
4. Introduzca el PIN.
5. Realice los ajustes deseados.
6. Acto seguido guarde la configuración en el teléfono. Para ello haga clic 

sucesivamente en Fichero > Guardar > Teléfono.

Ελληνικά
Σημαντικές πληροφορίες

Υποδείξεις ασφαλείας
Προειδοποίηση: Η ακατάλληλη χρήση της συσκευής μπορεί να οδηγήσει 
σε θανατηφόρο ηλεκτροπληξία και να προκαλέσει ζημιές ή να καταστρέψει 
τη συσκευή.

•   Διαβάστε τις οδηγίες χρήσης που συνοδεύουν τη συσκευή και φυλάξτε τις.
•   Συνδέετε το καλώδιο σύνδεσης της συσκευής μόνο στις σχετικά 

προβλεπόμενες και σωστά τοποθετημένες πρίζες
•   Χρησιμοποιείτε αποκλειστικά γνήσια εξαρτήματα και ανταλλακτικά.

Προειδοποίηση: Η ελλιπής ή εσφαλμένη ρύθμιση ενδέχεται να θέσει σε 
κίνδυνο άτομα, π. χ. λόγω μη εκτελέσιμων κλήσεων έκτακτης ανάγκης.

•   Η ρύθμιση του προϊόντος πραγματοποιείται μέσω του τηλεφώνου ή μέσω του 
λογισμικού COMfortel Set. Η σχετική βοήθεια διατίθεται στην αγγλική ή στη 
γερμανική γλώσσα. Αν δεν είστε εξοικειωμένοι με αυτές τις γλώσσες και τους 
χρησιμοποιούμενους ειδικούς όρους, συμβουλευτείτε τεχνικά και γλωσσικά 
κατάλληλο εξειδικευμένο προσωπικό.

Προειδοποίηση: Η χρήση εσφαλμένου τροφοδοτικού μπορεί να οδηγήσει 
σε θανατηφόρο ηλεκτροπληξία και να προκαλέσει ζημιές ή να καταστρέψει 
το τηλέφωνο.

•   Χρησιμοποιήστε μόνο το τροφοδοτικό αρ. τύπου FW7577/EU/40.

Προειδοποίηση: Η εισχώρηση υγρών στο περίβλημα μπορεί να οδηγήσει 
σε θανατηφόρο ηλεκτροπληξία και να προκαλέσει ζημιές ή να καταστρέψει 
τη συσκευή.

•   Λειτουργείτε το τηλέφωνο μόνο σε κλειστούς, ξηρούς χώρους.
•   Καθαρίζετε τη συσκευή μόνο με ελαφρώς βρεγμένο πανί ή με αντιστατικό πανί.

Προειδοποίηση: Κατεστραμμένα καλώδια, καθώς και ζημιές στο 
περίβλημα και την ίδια τη συσκευή μπορούν να οδηγήσουν σε θανατηφόρο 
ηλεκτροπληξία.

•   Μην θέτετε σε λειτουργία μια κατεστραμμένη συσκευή.

Προειδοποίηση: Οι υπερτάσεις που συμβαίνουν κατά τη διάρκεια 
καταιγίδων μπορούν να προκαλέσουν θανατηφόρο ηλεκτροπληξία και να 
προκαλέσουν ζημιές ή να καταστρέψουν τη συσκευή.

•   Αποφεύγετε κατά τη διάρκεια καταιγίδων την επαφή με τη συσκευή.
•   Αναθέστε σε έναν εξειδικευμένο ηλεκτρολόγο να τοποθετήσει όλα τα καλώδια 

εντός του κτιρίου.

Προειδοποίηση: Ακατάλληλα σετ ακουστικών, εξωτερικά ηχεία ή 
ακουστικά μπορούν να οδηγήσουν σε βλάβες στην ακοή ή να προκαλέσουν 
παρεμβολές στη σύνδεση συνομιλίας.

•   Τηρείτε τα τεχνικά στοιχεία για τη σύνδεση σετ ακουστικών.

Προειδοποίηση: Λόγω του ασθενούς μαγνητικού πεδίου στο ακουστικό τα 
αντικείμενα που προσελκύονται, όπως βελόνες και συνδετήρες, μπορούν 
να οδηγήσουν σε τραυματισμούς.

•   Μην τοποθετείτε το ακουστικό κοντά σε τέτοιου είδους αντικείμενα.

Προειδοποίηση: Κίνδυνος ασφυξίας. Η συσκευή περιέχει μικρά κομμάτια 
με κίνδυνο κατάποσης από μικρά παιδιά.

•   Φυλάσσετε τη συσκευή μακριά από μικρά παιδιά

Σημαντικό: Η συσκευή δεν έχει σχεδιαστεί και δεν πρέπει επομένως να 
χρησιμοποιείται σε συστήματα ή/και εφαρμογές υποστήριξης ζωτικών λειτουργιών 
μέσα σε πυρηνικές εγκαταστάσεις. Πριν από τη χρήση της συσκευής σε τέτοιες 
εφαρμογές θα πρέπει να προηγείται υποχρεωτικά μια προσαρμοσμένη στη 
συγκεκριμένη περίπτωση έγγραφη συγκατάθεση/δήλωση του κατασκευαστή
Η μη προβλεπόμενη χρήση μπορεί να οδηγήσει, π. χ. σε λειτουργικούς 
περιορισμούς ή διαταραχές, στην καταστροφή της συσκευής ή στη χειρότερη 
περίπτωση στον τραυματισμό ατόμων.
•   Αν δεν είστε βέβαιοι για την προβλεπόμενη χρήση ακόμα και μετά την 

ανάγνωση του επόμενου κεφαλαίου, ρωτήστε τον εξειδικευμένο έμπορό σας.
•   Διαβάστε τις οδηγίες χρήσης που συνοδεύουν τη συσκευή και φυλάξτε τις για 

μελλοντική χρήση.
•   Για τη χρήση ορισμένων λειτουργιών απαιτείται ενεργοποίηση στον φορέα 

εκμετάλλευσης, ενημέρωση υλικολογισμικού ή/και ρύθμιση μέσω του 
COMfortel Set. 

Προβλεπόμενη χρήση
Τηλέφωνο συστήματος για σύνδεση στην εσωτερική θύρα S0 ή θύρα UP0 ενός 
τηλεφωνικού κέντρου της Auerswald/FONtevo (βλέπε τεχνικά στοιχεία). Δεν 
προβλέπεται η σύνδεση σε ένα τηλεφωνικό κέντρο κάποιου άλλου κατασκευαστή 

ή στην εξωτερική σύνδεση S0 ενός φορέα εκμετάλλευσης. Το τηλέφωνο είναι 
ενσύρματο και προορίζεται για λειτουργία σε κλειστούς, ξηρούς χώρους.

Τεχνικά στοιχεία

Τεχνικά στοιχεία για τη σύνδεση ενός σετ ακουστικών

Περιβαλλοντικές υποδείξεις
Σε περίπτωση που η συσκευή συμπληρώσει την ωφέλιμη διάρκεια ζωής της, 
φροντίστε για την κατάλληλη απόρριψη (όχι μαζί με τα συνήθη οικιακά 
απορρίμματα).

Απορρίψτε το υλικό συσκευασίας σωστά, φροντίζοντας για την προστασία 
του περιβάλλοντος.

Πληροφορηθείτε από τη δημοτική ή τοπική αρχή για τις δυνατότητες σωστής 
και φιλικής προς το περιβάλλον απόρριψης της συσκευής. Αν θέλετε να 
αναλάβουμε εμείς την απόρριψη, στείλτε τη συσκευή σας με δική σας 
επιβάρυνση στην Auerswald GmbH & Co. KG.

Δήλωση συμμόρφωσης
Αυτή η συσκευή συμμορφώνεται με τις βασικές απαιτήσεις υγείας, ασφαλείας και 
περιβάλλοντος όλων των σχετικών ευρωπαϊκών οδηγιών. Μπορείτε να δείτε τη 
δήλωση συμμόρφωσης στο διαδίκτυο.

Οδηγίες χρήσης
Οι οδηγίες χρήσης "Περισσότερες πληροφορίες" υπάρχουν στο COMfortel Set και στο διαδίκτυο. Οι συνοπτικές οδηγίες 
χρήσης υπάρχουν στο διαδίκτυο. Μετά την ενημέρωση του υλικολογισμικού θα χρειαστείτε ενδ. ενημερωμένες οδηγίες 
χρήσης. Μπορείτε να τις βρείτε στο διαδίκτυο.

Όροι παροχής εγγύησης
1. Η Auerswald GmbH & Co. KG, Vor den Grashöfen 1, D-38162 Cremlingen, παρέχει ως κατασκευαστής αυτού του 
προϊόντος εγγύηση κατασκευαστή 24 μηνών από την ημερομηνία αγοράς.
2. Για εσάς ως καταναλωτή αυτό σημαίνει: Εγγυόμαστε ότι οι συσκευές μας είναι απαλλαγμένες από σφάλματα κατά την 
παράδοση και εξασφαλίζουμε 24 μήνες από αυτήν την ημερομηνία δωρεάν επισκευή ή δωρεάν αντικατάσταση, σε 
περίπτωση σφάλματος κατασκευής και παραιτούμαστε από το αποδεικτικό που πρέπει να υποβληθεί από εσάς ως 
καταναλωτή, σύμφωνα με τη νόμιμη εγγύηση, σχετικά με το ότι αυτό το σφάλμα υπήρχε ήδη το χρονικό σημείο της 
παράδοσης. Κατά την επισκευή ή την παράδοση της αντικατάστασης χρησιμοποιούμε είτε καινούργια είτε 
ανακατασκευασμένα μέρη. Τα μέρη που ενδεχομένως θα αφαιρεθούν από τη συσκευή περνούν στην ιδιοκτησία μας και 
επιτρέπεται να καταστραφούν.
3. Εκτός από την παρούσα εγγύηση ο πελάτης δικαιούται πλήρως τα νόμιμα δικαιώματα, όπως προκύπτουν από την 
εγγύηση περί ελαττωμάτων βάσει της σύμβασης αγοράς απέναντι στον προμηθευτή. Η νόμιμη εγγύηση περί ελαττωμάτων 
αφορά ωστόσο σε αντίθεση με τη δική μας εγγύηση κατασκευαστή μόνο την κατάσταση κατά το χρονικό σημείο της 
πώλησης (παράδοση). 
4. Μπορείτε να επωφεληθείτε της παρούσας εγγύησης μόνο αν στείλετε την ελαττωματική συσκευή μαζί με μια σαφή 
απόδειξη αγοράς (τιμολόγιο ή απόδειξη) με δικά σας έξοδα στην Auerswald GmbH & Co. KG ή εκτός Γερμανίας σε δικό μας 
γενικό εισαγωγέα ή τοπικό διανομέα. Στην αποστολή συμπεριλάβετε λεπτομερή περιγραφή του σφάλματος και δηλώστε 
και τον αριθμό τηλεφώνου σας για ενδεχόμενες περαιτέρω ερωτήσεις. Για να αποφύγετε ζημιές κατά τη μεταφορά, 
χρησιμοποιήστε κατάλληλη συσκευασία μεταφοράς (π. χ. η αρχική συσκευασία μαζί με εξωτερικό χαρτόνι).
5. Από την εγγύηση κατασκευαστή εξαιρούνται οι ζημιές που προκαλούνται από ακατάλληλο χειρισμό, σφάλματα 
χειρισμού, εσφαλμένη χρήση, εξωτερικές επιρροές, αστραπές/υπέρταση, μετατροπές στο προϊόν, καθώς και επεκτάσεις. 
Επιπλέον, εξαιρούνται τα εξαρτήματα φθοράς (π. χ. μπαταρίες, ασφάλειες, συσσωρευτές, κάρτες αποθήκευσης), καθώς 
και οι ζημιές που προκαλούνται από εξαρτήματα φθοράς (π.χ. λόγω διαρροής των μπαταριών). Επίσης, εξαιρούνται οι 
ζημιές κατά τη μεταφορά, οι επακόλουθες ζημιές, τα κόστη αστοχιών και των διαστημάτων μετακινήσεων.
6. Η εγγύηση παύει να ισχύει όταν οι επισκευές εκτελούνται από μη εξουσιοδοτημένα άτομα. 

Πρώτη θέση σε λειτουργία
Συνδέστε το τηλέφωνο, όπως εμφανίζεται στην εικόνα για τη σύνδεση.

Αρχική ρύθμιση μέσω του τηλεφώνου
Προϋποθέσεις:
• Στον εσωτερικό αριθμό κλήσης που έχει ρυθμιστεί στο τηλεφωνικό κέντρο
Ακολουθήστε τις οδηγίες χρήσεις στο τηλέφωνο. 

Υπόδειξη: Το MSN είναι ο εσωτερικός αριθμός κλήσης που έχει ρυθμιστεί στο 
τηλεφωνικό κέντρο.

Ρύθμιση μέσω του COMfortel Set
Προϋποθέσεις:
• Το Java Runtime έχει εγκατασταθεί (μπορείτε να το βρείτε στο διαδίκτυο)
• Το COMfortel Set έχει εγκατασταθεί (μπορείτε να το βρείτε στο διαδίκτυο)
• Υπάρχουσα σύνδεση του υπολογιστή σε μια θύρα υπολογιστή του 

τηλεφωνικού κέντρου (βλέπε οδηγίες χρήσης του τηλεφωνικού κέντρου)
1. Εκκινήστε το πρόγραμμα.
2. Επιλέξτε στο Επιλογές> Διασύνδεση τις χρησιμοποιούμενες από εσάς 

θύρες (π. χ. Δίκτυο IP κατά τη σύνδεση του υπολογιστή στο τηλεφωνικό 
κέντρο μέσω του τοπικού δικτύου).

3. Κάντε κλικ στη διαδρομή Άνοιγμα> Τηλέφωνο και επιλέξτε το σχετικό 
τηλέφωνο.

4. Καταχωρίστε το PIN.
5. Πραγματοποιήστε τις επιθυμητές ρυθμίσεις.
6. Βεβαιωθείτε στη συνέχεια, για τη διαμόρφωση, στο τηλέφωνο. Πατήστε προς 

τούτο διαδοχικά στο Αρχείο> Αποθήκευση> Τηλέφωνο.

Operating voltage Power via the internal S0 or UP0 port from the PBX. 
With COMfortel Xtension300: Power provided via 
wall-mounted power supply at 230 V ~; +/- 10 %, 
50 Hz

Wall-mounted 
power supply

Type no. FW7577/EU/40

Power 
consumption

Min. 1.1 W, max. 1.9 W; COMfortel Xtension300: 
+0.6 W

System 
connection

Internal S0 port or UP0 port from one of the following 
PBXs: COMpact 3000 analog/ISDN/VoIP, 
COMpact 2206 USB, COMpact 4410 USB, 
COMpact 5010 VoIP, COMpact 5020 VoIP, 
COMpact 4000, COMpact 5000/R, COMpact 5200/
R, COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19", COMmander Business/
19"

PC/data interface USB
Displays 18 LEDs, 15 of which are polychromatic. 4.3" TFT 

colour display, 480 x 272 pixels, backlight

COMfortel Xtension300: 30 LEDs, polychromatic
User elements Keypad, 12 permanently assigned function keys, 

colour display with touch operation, directional pad, 
15 programmable function keys with LED (on which 
up to two functions can be assigned on two levels)

COMfortel Xtension300: 30 programmable function 
keys

Receiver Wideband audio, electret microphone, dynamic 
receiver loudspeaker, hearing aid compatible

Headset Separate interface for dynamic headsets, also with 
DHSG (wireless headset) support

Hook key Magnetic switch contact
Casing Plastic material, black, white
Dimensions 275 mm x 128/150/170 mm x 210 mm (W x H x 

D);COMfortel Xtension300: 120 x 68/90/110 x 210 
Weight Approx. 1050 g; COMfortel Xtension300: approx. 

310 g
Temperature Operation: 0 to 40 °C, storage: - 30 to + 70 °C, non-

condensing
Security CE

Microphone current consumption Max. 0.5 mA
Microphone sensitivity 45 dB
Loudspeaker impedance 150 Ohm
Loudspeaker sensitivity at 1 kHz 19.5 +/- 3 dBPa/V
Sound level threshold 24 dBPa

Tensión de 
servicio

Alimentación a través de puerto interno S0 o UP0 de 
la centralita; con COMfortel Xtension300: Es 
necesaria una alimentación a través de un 
transformador de enchufe; 230 V ~; +/- 10 %, 50 Hz

Transformador de 
enchufe

Modelo n.º FW7577/EU/40

Potencia 
absorbida

Mín. 1,1 W, máx. 1,9 W; COMfortel Xtension300: 
+0,6 W

Conexión del 
sistema

Puerto interno S0 o UP0 de las centralitas: 
COMpact 3000 analógica/RDSI/VoIP, 
COMpact 2206 USB, COMpact 4410 USB, 
COMpact 5010 VoIP, COMpact 5020 VoIP, 
COMpact 4000, COMpact 5000/R, COMpact 5200/
R, COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19", COMmander Business/
19"

Interfaz de datos/
PC

USB

Indicadores 18 LED, 15 de ellos de varios colores, pantalla a 
color TFT de 4,3 pulgadas, 480 x 272 píxeles, 
retroiluminación

COMfortel Xtension300: 30 LED de varios colores
Elementos de 
mando

Teclado de marcado, 12 teclas con funciones fijas, 
pantalla a color con función táctil, pad de control, 
15 teclas de función programables con LED (se les 
puede asignar hasta dos funciones a cada una en 
dos niveles)

COMfortel Xtension300: 30 teclas de función 
programables

Microteléfono Audio de banda ancha, micrófono electret, altavoces 
dinámicos, compatible con audífonos

Auriculares Interfaz independiente para auriculares con cable, 
también con compatibilidad DHSG

Gancho 
conmutador

Contacto de maniobra magnético

Carcasa Plástico, negro, blanco
Dimensiones 275 mm x 128/150/170 mm x 210 mm (an x al x f); 

COMfortel Xtension300: 120 x 68/90/110 X 210 
Peso Aprox. 1050 g; COMfortel Xtension300: aprox. 310 g
Temperatura Funcionamiento: De 0 a 40 °C, almacenamiento: De 

- 30 a + 70 °C, sin condensación
Seguridad CE

Consumo de potencia micrófono Máx. 0,5 mA
Sensibilidad micrófono 45 dB
Impedancia altavoz 150 ohmios
Sensibilidad altavoz a 1 kHz 19,5 +/- 3 dBPa/V
Límite de nivel sonoro 24 dBPa

Τάση λειτουργίας Τροφοδοσία μέσω εσωτερικής θύρας S0 ή UP0 από 
το τηλεφωνικό κέντρο, με COMfortel Xtension300: 
Τροφοδοσία απαραίτητα μέσω τροφοδοτικού, 230 V 
~, +/- 10 %, 50 Hz

Τροφοδοτικό Αρ. τύπου FW7577/EU/40
Κατανάλωση 
ισχύος

Ελάχ. 1,1 W, μέγ. 1,9 W, COMfortel Xtension300: 
+0,6 W

Σύνδεση 
συστήματος

Εσωτερική θύρα S0 ή UP0των τηλεφωνικών 
κέντρων: COMpact 3000 αναλογικό/ISDN/VoIP, 
COMpact 2206 USB, COMpact 4410 USB, 
COMpact 5010 VoIP, COMpact 5020 VoIP, 
COMpact 4000, COMpact 5000/R, COMpact 5200/
R, COMpact 5500R, COMmander 6000/R/RX. 
COMmander Basic 2/19", COMmander Business/
19"

Θύρες 
υπολογιστή/
δεδομένων

USB

Προβολή 18 λυχνίες LED, 15 από αυτές πολύχρωμες, 
έγχρωμη οθόνη 4,3 ιντσών TFT, 480 x 272 pixel, 
φωτισμός φόντου

COMfortel Xtension300: 30 λυχνίες LED, 
πολύχρωμες

Στοιχεία χειρισμού Πληκτρολόγιο επιλογής αριθμών, 12 πλήκτρα 
σταθερής λειτουργίας, έγχρωμη οθόνη με λειτουργία 
αφής, πληκτρολόγιο κλήσης, 15 προγραμματιζόμενα 
πλήκτρα λειτουργίας με λυχνία LED (δυνατότητα 
αντιστοίχισης έως και δύο λειτουργίες σε δύο 
επίπεδα)

COMfortel Xtension300: 30 προγραμματιζόμενα 
πλήκτρα λειτουργίας

Ακουστικό Wideband audio, μικρόφωνο Elektret, δυναμικό 
ηχείο ακουστικού, συμβατό με ακουστικές συσκευές

Σετ ακουστικών Ξεχωριστές θύρες για ενσύρματα σετ ακουστικών, 
και με υποστήριξη ασύρματων ακουστικών με 
μικρόφωνο (DHSG)

Διακόπτης 
αγκίστρου

Μαγνητική επαφή διακόπτη

Περίβλημα Πλαστικό, μαύρο, λευκό
Διαστάσεις 275 mm x 128/150/170 mm x 210 mm (Π x Υ x B), 

COMfortel Xtension300: 120 x 68/90/110 X 210 
Βάρος Περ. 1050 g, COMfortel Xtension300: Περ. 310 g
Θερμοκρασία Λειτουργία: 0 έως 40 °C, αποθήκευση: - 30 έως 

70 °C, χωρίς συμπύκνωση
Ασφάλεια CE

Κατανάλωση ισχύος μικροφώνου Μέγ. 0,5 mA
Ευαισθησία μικροφώνου 45 dB
Αντίσταση ηχείου 150 Ohm
Ευαισθησία ηχείου σε 1 kHz 19,5 +/- 3 dBPa/V
Όρια στάθμης ήχου 24 dBPa
Gerätefüße (de) / Device feet (en) / Soportes del dispositivo (es) / Βά-
σεις συσκευής (el) / Pieds d’appareil (fr) / Piedini del dispositivo (it) / 
Voeten apparaat (nl) / Nóżki urządzenia (pl)

* Gerätefüße umstecken und nicht drehen (de)
* Unplug and reinsert device feet. Do not rotate. (en)
* Conecte los soportes sin girarlos (es)
* Επανατοποθετήστε τις βάσεις συσκευής και μην τις περιστρέφετε (el)
* Défichez les pieds d’appareil et ne les tournez pas (fr)
* Estrai i piedini del dispositivo e inseriscili nella posizione desiderata, non ruotarli (it)
* voeten apparaat herpositioneren en niet draaien (nl)
* Przełożyć nóżki urządzenia i nie obracać (pl)

Montage (de) / Assembly (en) / Montaje (es) / Συναρμολόγηση (el) / 
Montage (fr) / Montaggio (it) / Montage (nl) / Montaż (pl)
Montage des Tastenerweiterungmoduls mit Spezialverbinder und Verbindungskabel (nicht im Lieferumfang) de

Assemble the key extension module with special fasteners and connection cable (not included in the scope
of delivery) en

Montaje de la extensión del teclado con conector especial y cable de conexión (no incluido) es

Συναρμολόγηση δομοστοιχείου επέκτασης πλήκτρου με ειδικό σύνδεσμο και καλώδιο σύνδεσης (δεν περι-
λαμβάνεται στα παραδοτέα) el

Montage du module d’extension de touches avec connecteur spécial et câble de raccordement (non compris
dans la livraison) fr

Montaggio del modulo estensione tasti con connettore speciale e cavo di collegamento (non in dotazione) it

Montage van de toetsuitbreidingsmodule met speciale verbinder en verbindingskabel (niet bij de levering
inbegrepen) nl

Montaż modułu rozszerzenia klawiatury z łącznikiem specjalnym i kablem połączeniowym (nie znajduje się w
zakresie dostawy) pl

*

1)

2)
Anschluss (de) / Connection (en) / Conexión (es) / Σύνδεση (el) / Rac-
cordement (fr) / Collegamento (it) / Aansluiting (nl) / Przyłącze (pl)

1) Brückenstecker ist bei Auslieferung des Geräts eingesteckt. Für den Betrieb von Tastenerweiterungs-
modulen entfernen.
2) Stattdessen ein Steckernetzteil mit der Typ-Nr. FW7577/EU/40 (nicht im Lieferumfang) einstecken.

de

1) The bridge plug is plugged into the device when it is delivered. Remove it when using key extension 
modules.
2) Use a wall-mounted power supply of type number FW7577/EU/40 (not included in the scope of delivery) 
instead.

en

1) El conector puente está conectado en la configuración de fábrica del dispositivo. Debe retirarse si se 
van a utilizar extensiones de teclado.
2) En su lugar debe conectarse un transformador de enchufe con el modelo n.ºFW7577/EU/40 (no 
incluido).

es

1) Το φις γεφύρωσης είναι τοποθετημένο κατά την παράδοση. Για τη λειτουργία των δομοστοιχείων επέ-
κτασης πλήκτρου αφαιρέστε το.
2) Στη θέση του χρησιμοποιήστε ένα τροφοδοτικό με αρ. τύπου FW7577/EU/40 (δεν περιλαμβάνεται στα 
παραδοτέα).

el

1) À la livraison de l’appareil, un cavalier est branché. Retirez-le pour le fonctionnement des modules 
d’extension de touches.
2) Branchez à la place un bloc d’alimentation de type n° FW7577/EU/40 (non compris dans la livraison).

fr

1) La spina a ponte è inserita di fabbrica. Per utilizzare uno o più moduli di estensione tasti è necessario 
estrarla.
2) Al suo posto inserisci un alimentatore a spina del tipo FW7577/EU/40 (non in dotazione).

it

1) Brugstekker is bij de levering van het apparaat ingeplugd. Voor gebruik van de toetsuitbreidingsmodules 
verwijderen.
2) In plaats daarvan een adapter met het type-nr. FW7577/EU/40 (niet bij de levering inbegrepen) inplug-
gen.

nl

1) Wtyk mostkujący jest włożony w momencie dostawy urządzenia. Wyjąć w celu używania modułów roz-
szerzenia klawiatury.
2) Podłączyć wtykowy zasilacz sieciowy o nr. typu FW7577/EU/40 (nie znajduje się w zakresie dostawy).

pl

* Nicht im Lieferumfang / ** Bei Betrieb ohne Tastenerweiterungsmodul eingesteckter Brückenstecker. de

* Not included in the scope of delivery / ** If no key extension module has been installed, no additional wall-
mounted power supply is required, but the socket used for that power supply must have a bridge plug 
plugged into it. This bridge plug bridges connections.

en

* No incluido / ** Conector puente conectado si se utiliza sin extensión de teclado. es

* Δεν περιλαμβάνεται στα παραδοτέα/** Σε λειτουργία χωρίς τοποθετημένο φις γεφύρωσης δομοστοιχείου 
επέκτασης πλήκτρου.

el

*

**
Headsetbuchse (de) / Headset socket (en) / Conexión auriculares (es) 
/ Υποδοχή σετ ακουστικών (el) / Connecteur micro-casque (fr) / Presa 
per cuffia auricolare (it) / Aansluiting headset (nl) / Gniazdo zestawu 
słuchawkowego (pl)

* Non compris à la livraison / ** En cas de fonctionnement sans module d’extension de touches, cavalier 
enfiché.

fr

* Non in dotazione / ** Spina a ponte inserita da utilizzare in mancanza del modulo estensione tasti. it

* Niet bij de levering inbegrepen/** Bij gebruik zonder toetsuitbreidingsmodule ingeplugde brugstekker. nl

* Nie znajduje się w zakresie dostawy / ** Podczas użytkowania bez modułu rozszerzenia klawiatury 
wetknięty wtyk mostkujący.

pl

1 DHSG BUS_IN

2 DHSG GND

3 - Mikrofon (de) / Microphone (en) / Micrófono (es) / Μικρόφωνο (el) / Microphone (fr) / Microfono 
(it) / Microfoon (nl) / Mikrofon (pl)

4 - Lautsprecher (de) / Loudspeaker (en) / Altavoz (es) / Ηχείο (el) / Haut-parleur (fr) / Altoparlante 
(it) / Luidspreker (nl) / Głośnik (pl)

5 + Lautsprecher (de) / Loudspeaker (en) / Altavoz (es) / Ηχείο (el) / Haut-parleur (fr) / Altoparlante 
(it) / Luidspreker (nl) / Głośnik (pl)

6 + Mikrofon (de) / Microphone (en) / Micrófono (es) / Μικρόφωνο (el) / Microphone (fr) / Microfono 
(it) / Microfoon (nl) / Mikrofon (pl)

7 DHSG + 3,3 V

8 DHSG BUS_OUT
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